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About this information product

Purpose This CentreVu® Visual Vectors User Guide, 585–210–944, is written 
primarily for the CentreVu Call Management System (CMS) administrator 
who has access to all areas on one or more CentreVu CMS servers, and 
secondarily, for auxiliary administrators and split/skill supervisors who have 
limited access to Vectors and Vector Directory Numbers.

This book specifically addresses the DEFINITY Enterprise Communications 
Server (ECS) functionality of CentreVu CMS. If you are implementing the 
CentreVu CMS R3V9 server for the first time, you will have DEFINITY ECS 
R9.1. This call center configuration supports all of the functions that are 
accessible using CentreVu Visual Vectors software.

Where to begin

Read Chapter 2,  Setting up your Call Center World and Chapter 3,  Using 
CentreVu Framework to learn how to use the CentreVu Framework interface.

Reason for reissue This document is being reissued to support CentreVu Visual Vectors Version 
9.

Safety labels This is not applicable to this guide.
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How to use this
information product

The following table describes the contents of each major section of this 
document.

Conventions used The following conventions are used throughout this document.

Product release

Unless otherwise noted, the term DEFINITY Enterprise Communications 
Server (ECS) refers to Release 9.1. The functionality of earlier switch 
releases is noted if it differs from that of Releases 8 and 9.1. 

Document number

Publication titles are followed by their document number. For example, 
see CentreVu Visual Vectors Installation & Getting Started, 585–210–947, 
for more information.

Title Contents

Introduction Generally describes CentreVu Framework and Visual Vectors and 
includes things you should know before using the product.

Setting up your Call 
Center World

Describes how to use the Navigator tool to set up the objects in your Call 
Center World.

Using Framework Describes the CentreVu Framework tool.

Using Navigator Tells you how to view objects and perform actions with the Navigator 
tool.

Using the Vector Editor Tells you how to use the Vector Editor to create new and edit existing 
vectors, as well as to attach comments, display and print vectors. 

Using the VDN 
Administration Wizard

Tells you how to use this wizard-based tool to assign VDNs to vectors 
and set Skill Preferences.

Using the Import 
Export Wizard

Explains how to use this wizard-based tool to share vectors by exporting 
them to a ScratchPad or ACD, which allows other users to import the 
vectors.
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Typography

Italic font indicates:

• The titles of books and CD-ROMs. For example: For more 
information, see “Starting Visual Vectors” in Chapter 6, “Getting 
started with CentreVu Visual Vectors,” of CentreVu Visual Vectors 
Installation and Getting Started, 585-210-947.

• Emphasis. For example: The collect step is not available for non 
prompting vectors.

• Indicating the use of a word as a word. For example: The system 
flashes the word working at the bottom of the screen while it 
completes this process.

Courier font designates input and output.

• Input is something you type into the user interface. For example, 
Enter 6DOHV�to match and display available VDNs named 3UH�
6DOHV, 6DOHV, and 6DOHV�6SOLW.

• Output is a character, word or phrase that the system generates. For 
example, 3OHDVH�ZDLW�IRU�LQLWLDOL]DWLRQ�����.

Related documentation There are many documents that can help you use CentreVu CMS to its 
maximum capability. The title and document number of the most 
important ones are listed here.

• Avaya Call Center V9 Change Description 585-215-942

• Avaya Call Center Documentation CD-ROM 585-215-926

• CentreVu Visual Vectors Installation and Getting Started 585-210–
947

• CentreVu CMS R3V9 Administration 585-214-015

• CentreVu CMS R3V9 Software Installation, Maintenance, and 
Troubleshooting 585-215-956

• CentreVu Supervisor Version 9 Reports 585-210-929

• CentreVu Call Center V9 Little Instruction Book Maintenance 585–
215–944

• CentreVu Call Center V9 Little Instruction Book Basic 
Administration 585–215–954

• CentreVu Call Center V9 Little Instruction Book Advanced 
Administration 585–215–955
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How to order this information product 

By telephone:

AVAYA Inc. Publications  Center
Voice: 1-800-457-1235 or International Voice: 317-322-6416
Fax: 1-800-457-1764 or International Fax: 317-322-6699

By mail:

AVAYA Inc. Technologies Publications Center
2855 N. Franklin Road
Indianapolis, IN 46219
US

Order:

Document No. 

, December 1999

For additional documents, see Related documentation (-ix).

You can be placed on a Standing Order list for this and other documents 
you may need. Standing Order will enable you to automatically receive 
updated versions of individual documents or document sets, billed to 
account information that you provide. For more information on Standing 
Orders, or to be put on a list to receive future issues of this document, 
please contact the Avaya Publications Center.
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1 Introduction

.........................................................................................................................................................................................................................................................
Overview

Purpose This CentreVu Visual Vectors User Guide gives you the information you need 
to use the client software package.

This chapter includes the following sections: 

• General information

• Things to know before using Visual Vectors

• Things to know about call center data

• Prerequisite system administration 

See the overview of each section for a preview of the section's contents.
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General information

.........................................................................................................................................................................................................................................................
Overview

Purpose This section presents a brief overview of what the software does, who 
uses it, and how it works, followed by an overview of supporting 
hardware and software.

In this section This section includes the following information:

• What is Visual Vectors software?

• Platforms and required software

• Supported switches

• Prerequisite switch and CentreVu CMS features
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.........................................................................................................................................................................................................................................................
What is Visual Vectors software?

Introduction CentreVu Call Management System (CMS) Visual Vectors software is a 
product used by businesses and organizations that have a DEFINITY 
Enterprise Communications Server (ECS) or other switch and that receive 
a large volume of telephone calls that are processed through the 
Automatic Call Distribution (ACD) and Call Vectoring features of the 
switch. CentreVu CMS collects call-traffic data, formats management 
reports, and provides an administrative interface to the ACD feature on 
the switch.

The CentreVu CMS administrator can access the CentreVu CMS 
database, generate reports, administer ACD parameters, and also monitor 
call activities to determine the most efficient service possible for the 
customers. The CentreVu CMS server supports CentreVu Supervisor 
client computers.

The Visual Vectors Server software runs on the same platform as 
CentreVu CMS and supports CentreVu Visual Vectors clients. Using the 
client software, administrators can change certain properties of call center 
entities, as well as create and edit vectors, assign Vector Directory 
Numbers (VDNs) to vectors, and set VDN Skill Preferences.

CentreVu CMS and Visual Vectors Server software interface with the Sun 
Microsystems, Inc. Solaris operating system. They use several system 
utilities to:

• Communicate with CMS terminals and printers

• Communicate with computers that are running CentreVu Supervisor 
and CentreVu Visual Vectors client software

• Log errors

• Execute processes
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.........................................................................................................................................................................................................................................................
Platforms and required software

Supported server
hardware platforms

Visual Vectors Server 9.0 software is certified to run on the following 
computers:

• Sun Microsystems, Inc. Sun Enterprise 3000

• Sun Microsystems, Inc. Sun Enterprise 3500

• Sun Microsystems, Inc. Sun Ultra 5

Recommended client
computer configuration

The recommended computer configuration required for CentreVu Visual 
Vectors V9 client software is the following:

• Intel Corporation Pentium or compatible processor, running at 300 
MHz or faster (the minimum supported processor speed is 133 MHz; 
however, performance may be unsatisfactory)

• A hard disk drive with 50 MB of free space

• A CD-ROM drive

• 64 MB RAM or 96 MB RAM if Visual Vectors is co-resident with 
CentreVu Supervisor (the minimum supported amount of physical 
memory is 48 MB). If your server has a large number of objects, for 
example, thousands of VDNs, it is advisable to have 96 MB RAM or 
more (128 MB RAM or more if running with CentreVu Supervisor). 

If you are running Microsoft Windows 2000, you will need an extra 
16 MB RAM.

• A video monitor and adapter set to at least 800x600x256 graphics 
resolution.

• Windows 95, Windows 98, Windows NT 4.0 (with Service Pack 4 or 
later), Windows 2000, or Windows Millennium Edition operating 
system.

Note: The required browser for CentreVu Visual Vectors online help 
system is Microsoft Internet Explorer 3.02 or later. Before installing 
CentreVu Visual Vectors, ensure that Microsoft Internet Explorer 
3.02 or later is correctly installed; however, it does not need to be set 
as your default browser or .htm application.

• A mouse or other pointing device that is compatible with one of the 
supported Windows operating systems.

• For Network connection:

– WinSock 1.1 compliant TCP/IP stack

– Xerox Corp. Ethernet communications board
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Required software for a
Windows-based client

platform

CentreVu Visual Vectors runs on a Microsoft Windows 95, Microsoft 
Windows 98, Windows NT 4.0, or Windows 2000 operating system. 
When running under Windows NT 4.0, CentreVu Visual Vectors V9 client 
software requires Service Pack 4 or later to be installed.

The required browser for CentreVu Visual Vectors online Help is 
Microsoft Internet Explorer 3.02 or later. Before installing CentreVu 
Visual Vectors, ensure that Microsoft Internet Explorer 3.02 or later is 
correctly installed; however, it does not need to be set as your default 
browser or .htm application.
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.........................................................................................................................................................................................................................................................
Supported switches

Switch names and
releases

CentreVu CMS and Visual Vectors Server software are certified to run 
with the following switches: 

• DEFINITY Enterprise Communications Server (ECS) Release 6.3

• DEFINITY ECS Release 7

• DEFINITY ECS Release 8

• DEFINITY ECS Release 9 and 10

Single and multiple
ACDs

Depending on which server you have and how the CentreVu CMS 
software was installed, the CentreVu CMS software can communicate 
with as many as eight ACDs. 

Depending on how the Visual Vectors Server software was installed and 
configured, the CentreVu Visual Vectors V9 client software can 
communicate with as many as 20 servers that are running CMS and 
Visual Vectors.

References to multiple ACDs in this document refer to configurations 
with multiple switches. If you have only one switch, you can ignore the 
considerations for multiple ACDs.
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.........................................................................................................................................................................................................................................................
Prerequisite switch and CentreVu CMS features

Introduction CentreVu CMS includes a feature for administering automatic call 
distribution (ACD) and optional features for managing aspects of the 
system. The features required to use CentreVu Visual Vectors software are 
described below.

ACD administration and
Visual Vectors

CentreVu CMS and Visual Vectors software provide an administrative 
interface to the switch. The CMS software supports CentreVu Supervisor 
clients. Using the Agent Administration and Call Center Administration 
areas, you can use CentreVu Supervisor to view or change various 
parameters on the switch that are related to ACD, Vectoring, and Expert 
Agent Selection (EAS). You can also run reports that describe your call 
center configuration.

For example, you can:

• Add agents to or remove agents from splits or skills

• Move extensions between splits

• Change skill assignments

• Change the following assignments: trunk group-to-split, trunk 
group-to-VDN, VDN-to-vector 

• Start an agent trace and list the agents being traced

The Visual Vectors Server software supports CentreVu Visual Vectors 
clients. Using the Visual Vectors client software, administrators can 
change certain properties of call center entities, as well as create and edit 
vectors, assign VDNs to vectors, and set VDN Skill Preferences.

The CentreVu Visual Vectors administrator should coordinate with the 
ECS switch administrator to be sure that the needed ACD and CMS 
configurations are understood by both administrator. 
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Vectoring and Visual
Vectors

The CentreVu CMS Call Vectoring feature enables you to create, copy, 
and edit vectors on any supported DEFINITY Enterprise 
Communications Server (ECS). Call vectors are user-defined, call-
processing programs. Call vectors direct calls to specified on-network or 
off-network destinations, to queues in ACD splits, or to treatments such as 
music, recorded announcements, forced disconnect, and forced busy. 
CentreVu Visual Vectors provides a visually rich, intuitive graphical user 
interface for this feature for call centers with DEFINITY ECS R6.3 or 
later and CentreVu CMS R3V9 servers.

On the DEFINITY ECS and CentreVu CMS, the Call Vectoring feature is 
a separately purchased feature that is required to use Visual Vectors 
software. 
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Things to know before using Visual 
Vectors

.........................................................................................................................................................................................................................................................
Overview

Purpose This section describes the interactions of CentreVu Visual Vectors 
software with other call center client software.

In this section This section includes the following information:

• Interactions with CentreVu Supervisor

• Interactions with CMS and Supervisor
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.........................................................................................................................................................................................................................................................
Interactions with CentreVu Supervisor

Introduction CentreVu Visual Vectors software is designed to work with CentreVu 
Supervisor Version 6 or later.

Interactions with
CentreVu Supervisor

If CentreVu Supervisor Version 6 or later is correctly installed on your 
client computer, the Visual Vectors CentreVu Framework window 
displays a toolbar icon which you can use to start CentreVu Supervisor. 
You can also select CentreVu Supervisor from the Tools menu. 

Although you may be able to run CentreVu Supervisor from Visual 
Vectors, the two software programs, CentreVu Visual Vectors and 
CentreVu Supervisor, do not interact directly. If information from the two 
programs does not seem to match, first try to log off the CentreVu CMS 
server in each program, and then log back on. This will cause CentreVu 
Supervisor to read the configuration file in Visual Vectors and respond 
with the correct information.

Using CentreVu
Supervisor

Use CentreVu Supervisor software to do the following:

• Generate reports on the VDNs, vectors, and skill preferences you 
assigned using CentreVu Visual Vectors tools

• Assign names to splits or skills, trunk groups, ACDs, Vectors, and 
VDNs in the CentreVu CMS Dictionary, so that the objects in your 
Call Center World have more meaningful names

If CentreVu Supervisor Version 8 or later is installed, there will be a 
CentreVu Visual Vectors icon on the CentreVu Supervisor toolbar.

See CentreVu Supervisor Version 9 Reports, 585–210–929, and CentreVu 
CMS Release 3 Version 9 Administration, 585–214-015, for more 
information.
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.........................................................................................................................................................................................................................................................
Interactions with CMS and Supervisor

Introduction CentreVu Visual Vectors software is designed to work with CentreVu 
CMS R3V6 or later.

Interactions with
CentreVu CMS R3V9

If information obtained from the two client software programs does not 
seem to match, log off the CentreVu CMS R3V9 server from each client 
software program, and then log back on. This will cause the CentreVu 
CMS R3V9 server software to read the configuration file in Visual 
Vectors and respond with the correct information.

Important! Edit vectors only in Visual Vectors. If you use any 
other way to edit vectors, such as a CMS terminal, the vector step 
comments will be converted to floating comments.

Using CentreVu
Supervisor

CentreVu Visual Vectors software is designed to work with CentreVu 
Supervisor Version 6 or later. Use CentreVu Supervisor software to do the 
following:

• Generate reports on the VDNs, vectors, and skill preferences you 
assigned using Visual Vectors tools.

• Assign names to entities such as splits or skills, trunk groups, ACDs, 
Vectors, and VDNs in the CentreVu CMS Dictionary. You can use 
the Navigator tool in Visual Vectors to give more meaningful names 
to these objects in your Call Center World.

See CentreVu Supervisor Version 9 Reports, 585-210-929, and CentreVu 
CMS Release 3 Version 9 Administration, 585–214–015, for more 
information.
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Things to know about call center data

.........................................................................................................................................................................................................................................................
Overview

Purpose This section describes the CentreVu processes for storing and tracking 
switch data for your call center. The information is intended to give you 
an overview of how CentreVu CMS works, where CentreVu CMS stores 
data, and how Visual Vectors Server software accesses CMS Dictionary 
and User Permissions data.

In this section This section includes the following information:

• How CentreVu CMS stores and tracks ACD data
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.........................................................................................................................................................................................................................................................
How CentreVu CMS stores and tracks ACD data

Real-time and historical
databases

CentreVu CMS stores the ACD data that is received from the switch in 
the real-time and historical databases. Within each of these databases, 
CentreVu CMS stores the specific ACD data for agents, splits or skills, 
trunks, trunk groups, vectors, and VDNs in separate database tables. Call 
work codes (CWC) also have separate database tables in the real-time and 
historical database.

Summarizing CMS data As CentreVu collects the real-time data from the ACD, the data is stored 
in the current intrahour interval tables (agent, split/skill, trunk, trunk 
group, vector, and VDN) until the end of the interval. At the end of the 
current intrahour interval, data is archived to the previous intrahour 
interval tables and to the intrahour historical tables. At the time that you 
designate, the historical intrahour data is summarized into daily data. At 
the end of your designated week, which is specified on the System Setup 
subsystem Storage Intervals window, the daily data is summarized into 
weekly data. On the first day of a new month, monthly summaries are 
generated from the daily data for the previous month.

CMS Dictionary The CMS Dictionary contains names for call center ACDs and their 
entities, including announcements, splits or skills, trunk groups, VDNs, 
and vectors. The assigned names appear on CMS reports to make them 
easier to interpret, as well as in Visual Vectors software to make it easier 
to use. You can use Visual Vectors tools to rename entities, or edit certain 
other properties of those entities, for example, their descriptions. See 
CentreVu CMS Release 3 Version 9 Administration, 585–215–015, for 
more information about the CentreVu CMS Dictionary.

User permissions Visual Vectors software determines what users can view and modify 
based on CMS User Permissions. For example, if a user has read access 
for an ACD and/or its vectors but does not have write access, the user is 
not able to use Vector Editor to save, or Navigator to copy, a vector to that 
ACD. Likewise, if a user does not have read or write access permissions 
for a certain type of entity, for example, VDNs, the folder for those 
entities on the ACD appears empty in Navigator. See CentreVu CMS 
Release 3 Version 9 Administration, 585–215–015, for more information 
about CentreVu CMS User Permissions.
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Prerequisite system administration

.........................................................................................................................................................................................................................................................
Overview

Purpose This section describes the system-level administration, including 
permissions, that is required before you can run CentreVu Visual Vectors 
software.

In this section This section consists of the following information:

• Configuring Visual Vectors Server

• Technical Support

• CentreVu Visual Vectors Training
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.........................................................................................................................................................................................................................................................
Configuring Visual Vectors Server

Introduction If you need to install and configure the CentreVu Visual Vectors Server, 
first see CentreVu CMS R3V9 Software Installation, Maintenance, and 
Troubleshooting, 585–210–956, for instructions on how to proceed. A 
brief outline follows of the procedures to install the CentreVu Visual 
Vectors Server software package.

Installing Visual Vectors
Server software

To install Visual Vectors Server software:

........................................................................................................................................................................

1 Log in as root.

........................................................................................................................................................................

2 Insert the CD-ROM and enter the following command:  /usr/sbin/
pkgadd -d /cdrom/cdrom0.

Result:  The system displays information about the CD contents.

........................................................................................................................................................................

3 Enter “1” or press Return to select Visual Vectors Server software for 
processing.

Result:  The system asks you if you want to continue.

........................................................................................................................................................................

4 Enter “y” to continue installation.

Result:  The system again displays information about the CD-ROM 
package.

........................................................................................................................................................................

5 After verifying this information, enter “q” at the prompt.

Result:  The system completes the installation process.

E N D  O F  S T E P S.................................................................................................................................................................................
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Initially setting up your
server software

To set up your server software:

........................................................................................................................................................................

1 At the system prompt, enter setupaas.

........................................................................................................................................................................

2 Select 1 from the displayed setup menu.

........................................................................................................................................................................

3 Enter the number of allowable concurrent logins. The maximum 
number is the number of purchased licenses.

E N D  O F  S T E P S.................................................................................................................................................................................

Starting Visual Vectors
Server software

To start the Visual Vectors Server software:

........................................................................................................................................................................

1 To start the Visual Vectors Server software, at the system prompt, enter 
“setupaas.”

........................................................................................................................................................................

2 Select “2” from the displayed setup menu.

........................................................................................................................................................................

3 Select “1” from the turn on/stop menu to start the software.

E N D  O F  S T E P S.................................................................................................................................................................................

Server performance The following information summarizes capacity limits for CMS hardware 
platforms running CentreVu Visual Vectors Server software:

Reports or VDNs CMS Hardware Platform Capacity Limits

Ultra 5 UE3000 
(1 CPU)

UE3000 
(2 CPUs)

E3500 
(2 CPUs)

E3500 
(4 CPUs)

Simultaneous realtime reports 300 400 800 1200 2400

Historical, forecasting, ICH,  
and agent trace reports per hour

120 160 320 480 960
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Delay estimates The following information estimates the delay (in seconds) to navigate 
VDNs for some CMS hardware platforms that are running CentreVu 
Visual Vectors Server software: 

ODBC reports per hour 120 160 320 480 960

Web hits per hour 60,000 80,000 160,000 240,000 480,000

VDNs on any single ACD 1950 2600 5200 7800 15,600

Reports or VDNs CMS Hardware Platform Capacity Limits

Ultra 5 UE3000 
(1 CPU)

UE3000 
(2 CPUs)

E3500 
(2 CPUs)

E3500 
(4 CPUs)

VDNs CMS Hardware Platform Delay in Seconds

Ultra 5 UE3000 
(1 CPU)

UE300 
(2 CPUs)

E3500 
(2 CPUs)

E3500 
(4 CPUs)

  250 5.8 4.5 2.3 1.5 0.8

  500 9.0 7.1 3.6 2.4 1.2

1000 15.6 12.2 6.1 4.1 2.1

2000 28.8 22.5 11.3 7.6 3.8

4000 55.2 43.1 21.6 14.6 7.3

8000 107.9 84.3 43.2 28.6 14.3
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.........................................................................................................................................................................................................................................................
Technical Support

If you have a problem If you have a problem with CentreVu Visual Vectors, first consult the 
following:

• Troubleshooting in this or your installation guide.

• Help's Contents, alphabetical Index, and full text Search function.

• The readme.txt file that is delivered with the software.

Important! The readme.txt file includes late-breaking changes to 
and news about the software. Use a text editor such as Notepad to 
read the file.

Information to provide
the system administrator

If these sources don't contain answers to your questions, contact the 
system administrator for your site's CentreVu CMS. The system 
administrator may need information from you:

• The version installed on your PC (select the About... item from the 
Help Menu and note the load number in the upper-right corner).

• The name or IP address of your CentreVu CMS server (the system 
administrator will know the version and load of CentreVu CMS 
installed on your server).

• The type of connection you have to the server (serial or over a 
network).

• The manufacturer and model of your PC, as well as the amount of 
RAM installed.
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.........................................................................................................................................................................................................................................................
CentreVu Visual Vectors Training

Training included with
software

If you are a customer located within the United States, your Avaya Project 
Manager should call 1-800-255-8988 to schedule the appropriate classes 
for you. For training outside of the United States, contact your local 
Avaya distributor or representative. 

Available courses The following table shows available training courses:.

Course Number PEC Course Name Description

 BTC124H  1460–057 DEFINITY ECS with EAS A 4-day course that provides training 
on the tasks that are required to set up a  
G3 switch with the EAS feature and 
design vectors.

 BTC138H DEFINITY ECS G3 ACD 
with Vectoring

A 4-day course that provides training 
on the tasks that are required to set up a 
CentreVu CMS call center application 
with the G3 switch and the EAS 
feature, administer CentreVu CMS, 
interpret reports on ACD activity, and 
use the Vectoring and Forecast 
features. 

 BTC429M 1470-016a DEFINITY ACD and 
Vectoring

This CD-ROM course lasts 
approximately 1.5 hours. It provides 
actual experience with administering 
the ACD feature with vectoring.

 BTC155H 1462-031 CentreVu Supervisor V6 
Administration with EAS

A 4.5-day class that provides training 
on the tasks that are required to 
administer CentreVu CMS using 
CentreVu Supervisor V6, interpret 
reports of ACD activity in the 
CentreVu Supervisor Interface, and use 
the vectoring and forecasting features 
in the CMS interface. 
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 BTC154H 1462-030 CentreVu Supervisor V6 
Administration

A 4.5-day class that provides training 
on the tasks that are required to 
administer CentreVu CMS using 
CentreVu Supervisor V6, interpret 
reports of ACD activity in the 
CentreVu Supervisor Interface, and use 
the vectoring and forecasting features 
in the CMS interface. 

BTC447M 1472-006 CentreVu Supervisor V6 
Administration

 (with and without EAS)

This CD-ROM course lasts 
approximately 4 hours. It provides 
training on the tasks that are required to 
administer CMS and how to use the 
CentreVu Supervisor tools. This course 
includes system simulations, exercises, 
and supporting material.

 BTC115H 1462-014 CentreVu CMS Custom 
Reports

A 3-day class that provides training on 
the tasks that are required to develop 
CMS custom reports.

 BTC450M 1472-005 CentreVu Advocate: 
Breakthrough Solutions

This CD-ROM course lasts 
approximately 4 hours. It provides 
training on how to use CentreVu 
Advocate to better manage call center 
resources. This course includes system 
simulations, exercises, and support 
material.

BTC467M Not listed CentreVu Visual Vectors 
User Training

This CD-ROM course lasts 
approximately 2 hours. It provides 
training on how to uses Visual Vectors 
to create vectors and how to assign 
VDNs to vectors. The course includes 
system simulations, exercises, and 
supporting material.

Course Number PEC Course Name Description
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Course notes

When your company purchases the CentreVu Visual Vectors software 
package, free training for two people is included. If your company wants 
to enroll additional people in courses, it needs to use Price Elements 
Codes (PECs) when enrolling the additional people.

The last lesson in the Administration courses is a half-day session that 
provides training on the Forecast feature. Students enrolled in the 
Administration courses can also view the Visual Vectors User Training 
CD-ROM during the last lesson. If your company has not purchased the 
Forecast or Vectoring features, you do not have to attend this session.

Other  training 

You may benefit by taking additional courses in the following subject 
areas: 

• Traffic Theory and Data Analysis

• Host Computer Administration

• Switch Administration

You automatically receive the following Individualized Learning Program 
booklets after one of your call center's employees is enrolled in the 
CentreVu CMS Administration course:

• ACD Fundamentals

• Vectoring and EAS Basics
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2 Setting up your Call Center World

.........................................................................................................................................................................................................................................................
Overview

Purpose This chapter explains how to set up the Call Center World seen in the 
Navigator. It includes the following sections:

• Introduction to your Call Center World

• Managing Call Center World objects

See the overview of each section for a preview of the section's contents.
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Introduction to your Call Center 
World

.........................................................................................................................................................................................................................................................
Overview

Purpose This section provides an introduction to Call Center World features and 
explains how to connect to a new CMS server or add a new CMS server to 
your Call Center World.

In this section This section includes the following information:

• Features of your Call Center World

• Using Visual Vectors windows

• Connecting to a CentreVu CMS server
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.........................................................................................................................................................................................................................................................
Features of your Call Center World

Overview Visual Vectors is object-oriented, which means that the system handles all 
entities as objects. An object is a set of computer instructions with 
properties you define. This chapter explains how to perform actions on 
objects in your Call Center World, including how to select objects, 
rename objects, delete objects, and so forth.
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.........................................................................................................................................................................................................................................................
Using Visual Vectors windows

Introduction This part explains how to use features that are common to all Visual 
Vectors windows, that is, menus, toolbars, and online Help.

Visual Vectors menus To select a menu item, choose any of the following methods:

• Click the item.

• Use the arrow keys to highlight the item and then press Enter.

• Hold down Alt and press the underlined letter in the menu item you 
want to select

• Press the key or combination of keys (usually the Alt key or the 
Control key and a letter key) assigned to the operation. For example, 
use Control+C to copy. 

Visual Vectors toolbars All items that are available on the Visual Vectors toolbars are also 
available from the menus. To select a toolbar item, click the icon.

Help system Press F1 or click Help to display Help for a window. Select Help from the 
menu bar to choose from the help options that are described in 
Framework window objects.
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.........................................................................................................................................................................................................................................................
Connecting to a CentreVu CMS server

Purpose You can use the Connect menu item or toolbar button to log in to a CMS 
server. 

Connection types From CentreVu Framework, you can connect to one or more existing 
CMS servers or you can add a new CMS server. Note that you are limited 
to one instance of a login ID per server.

Connecting to an
existing server in your

Call Center World

To establish a CMS connection when the server exists in your Call Center 
World:

........................................................................................................................................................................

1 Select Connect from the File menu, or click Connect on the toolbar.

The Connect to server window appears.

........................................................................................................................................................................

2 Type your CentreVu CMS login Id in the Login Id: text box.

........................................................................................................................................................................

3 Press the Tab key to move the cursor to the Password: text box.

........................................................................................................................................................................

4 Type your CMS password in the Password: text box.
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........................................................................................................................................................................

5 Select a CMS server in your Call Center World from the Connect to 
server: drop-down list.

........................................................................................................................................................................

6 Click Connect.

Result:  The system displays a status message that indicates that the 
software is connecting to the CMS server. If the connection is broken 
or dropped while you are working with tools, you will be prompted to 
save on-line open vectors elsewhere.

E N D  O F  S T E P S.................................................................................................................................................................................

Adding a new server to
your Call Center World

To establish a connection with a new CentreVu CMS server that is not 
already in your Call Center World: 

........................................................................................................................................................................

1 To establish a CMS connection, do one of the following:

• In the CentreVu Framework window, select Connect from the File 
menu.

• In the Navigator window, highlight Call Center World in the left-
hand pane, and then select New CMS from the File menu or shortcut 
menu.

• Click New in the Navigator toolbar.

The system displays the New CMS window.

........................................................................................................................................................................

2 Type the hostname or IP address of a CentreVu CMS Visual Vectors 
server in the Server Network Address: text box. 
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........................................................................................................................................................................

3 Type your CentreVu CMS login ID in the Login Id: text box.

........................................................................................................................................................................

4 Type your CMS password in the Password: text box.

........................................................................................................................................................................

5 Click OK.

Result:  If the CMS server you entered:

• Exists and can be connected to, a new CMS object is added to 
your Call Center World and you are connected to this new server. 
If the connection is broken or dropped while you are working 
with tools, you will be prompted to save on-line open vectors 
elsewhere.

• Does not exist or cannot be connected to, an error message is 
displayed showing the cause of the failure. Go back to Step 2 to 
enter the required information again.

E N D  O F  S T E P S.................................................................................................................................................................................
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Managing Call Center World objects

.........................................................................................................................................................................................................................................................
Overview

Purpose This section describes how to manage objects in your Call Center World.

In this section This section includes the following information:

• Selecting objects

• Adding objects

• Deleting objects

• Renaming objects

• Changing other object properties
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.........................................................................................................................................................................................................................................................
Selecting objects

Introduction To perform any action on an object in your Call Center World, you must 
first select the object. To select an object, choose either of the following 
methods: 

• Click the object.

• Use the arrow keys to highlight the item and then press Enter.

Input window actions The following table describes the features of the input window.

Feature Action

Menu bar Pull down a list of actions, edit options, and online Help.

Toolbar action 
buttons

Click a button to perform an action.

Input fields Type in the information that is needed to complete an 
action.

Selection list View a list of the content that you may enter in the input 
field.
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.........................................................................................................................................................................................................................................................
Adding objects

Introduction To add an object to your Call Center World (for example, a new vector for 
an ACD in the Vector Folder), you must first select a container for the 
object in a Navigator window. Note that if you add or save a vector to the 
Vector Folder on a measured ACD, it will be added to the CMS database.

Procedure To add a new vector or ScratchPad to your Call Center World:

........................................................................................................................................................................

1 In the Navigator window, highlight a ScratchPad or Vector Folder in 
the left-hand pane, and then click the right mouse button. The system 
displays the shortcut menu.
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........................................................................................................................................................................

2 Select a type of vector from the shortcut menu. If you highlighted a 
ScratchPad, you can also select ScratchPad from the menu.

The system displays the New Vector or New ScratchPad window.

........................................................................................................................................................................

3 Fill in the required information in the input fields in the window. For a 
new vector, you need to enter a name. If you are adding a new vector 
to an ACD, an Id is also required.

........................................................................................................................................................................

4 Click OK.

Result:  If the addition was:

• Successful, the system displays the new object in the Navigator 
window.

• Not successful, the system displays an error message showing 
the cause of the failure. 

E N D  O F  S T E P S.................................................................................................................................................................................
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.........................................................................................................................................................................................................................................................
Deleting objects

Procedure You may want to delete a CMS from your Call Center World or a vector 
from the CentreVu CMS database. You may need to obtain information 
from the CMS database before deleting the item for future reference.

Getting information To obtain information from the CMS database before you delete the item:

........................................................................................................................................................................

1 Select the object in the Navigator window and then do one of the 
following:

• Select Properties from the File menu or shortcut menu.

• Click Properties on the toolbar.

• Press Alt+Enter.

The system displays the Properties window.

........................................................................................................................................................................

2 Locate and note the relevant information. For example, verify that you 
have permission to delete the item.

........................................................................................................................................................................

3 Close the Properties window. 

E N D  O F  S T E P S.................................................................................................................................................................................

Performing the Delete To delete a CMS or vector from your Call Center World:
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........................................................................................................................................................................

1 Select the object in the Navigator window.

........................................................................................................................................................................

2 Do one of the following:

• Select Delete from the File menu or shortcut menu.

• Click Delete on the toolbar.

• Press Delete.

Result:  If the deletion was:

• Successful, the contents of the object (steps) are removed 
causing the vector to not appear in Navigator.

• Not successful, the system displays an error message showing 
the cause of the failure. 

E N D  O F  S T E P S.................................................................................................................................................................................
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.........................................................................................................................................................................................................................................................
Renaming objects

Introduction You may want to rename an object that already exists in your Call Center 
World. You may need to obtain information from the CMS database 
before renaming the item for future reference.

Getting information To obtain information from the CMS database before you rename the 
item:

........................................................................................................................................................................

1 Select the object in the Navigator window and then do one of the 
following:

• Select Properties from the File menu or shortcut menu.

• Click Properties on the toolbar.

• Press Alt+Enter.

The system displays the Properties window.

........................................................................................................................................................................

2 Locate and note the relevant information. For example, verify the type 
of the vector you want to rename.

........................................................................................................................................................................

3 Close the Properties window. 

E N D  O F  S T E P S.................................................................................................................................................................................
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Doing the renaming To rename an ACD object in the CMS database:

........................................................................................................................................................................

1 Select the object in the Navigator window.

........................................................................................................................................................................

2 Do one of the following:

• Select Rename from the File menu or shortcut menu.

• Click Rename on the toolbar.

The system displays the Renaming object window with the Name 
property field highlighted.

........................................................................................................................................................................

3 Type in the new name or edit the existing name and then click OK.

Result:  If the object was

• Renamed, the system displays the new name in the Navigator 
window.

• Not renamed, the system displays an error message that shows 
the cause of the failure. 

E N D  O F  S T E P S.................................................................................................................................................................................
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.........................................................................................................................................................................................................................................................
Changing other object properties

Introduction You may want to view or change the properties of a single object or of 
multiple objects in your Call Center World. 

Single object Follow this procedure if the Properties you want to change are for a single 
object or entity, that is, one split/skill, vector, VDN, or trunk group.

........................................................................................................................................................................

1 Select the object in the Navigator window and then do one of the 
following:

• Select Properties from the File menu or shortcut menu.

• Click Properties on the toolbar.

• Press Alt+Enter.

The system displays the Properties window.

The window contains properties of the object for which you have 
permissions in the CMS Dictionary.

........................................................................................................................................................................

2 Click in or use the Tab key to move to the fields in which you want to 
change the values.
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........................................................................................................................................................................

3 Type the new values in the fields.

Result:  The system displays a red box around any property fields 
with invalid values.

........................................................................................................................................................................

4 When you have made all of your changes and no red boxes are 
displayed, click OK.

E N D  O F  S T E P S.................................................................................................................................................................................

Multiple objects Follow this procedure if the Properties you want to change are for 
multiple objects or entities, that is, multiple splits or skills, vectors, 
VDNs, or trunk groups. 

........................................................................................................................................................................

1 Select the objects in the Navigator window and then do one of the 
following:

• Select Properties from the File menu or shortcut menu.

• Click Properties on the toolbar.

• Press Alt+Enter.

The system displays the Properties of many objects window.

The window contains properties of the objects for which you have 
permissions in the CMS Dictionary.
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........................................................................................................................................................................

2 Click in or use the Tab key to move to the fields in which you want to 
change the values.

........................................................................................................................................................................

3 Type the new values in the fields.

Result:  The system displays a red box around any property fields 
with invalid values.

........................................................................................................................................................................

4 When you have made all of your changes and no red boxes are 
displayed, click OK.

E N D  O F  S T E P S.................................................................................................................................................................................

Rules for field entry  When you change certain properties using Visual Vectors software, the 
CentreVu CMS server database is updated. CMS has three classes of input 
field: name (synonym), description, and number. This topic describes the 
rules that apply to each class.

Name A name (synonym) property field must begin with an alphabetic 
character. Characters are case sensitive.

A Name property field can consist of from 1 to 20 characters, which 
include:

• Letters

• Numbers

• Underscores (B)

• Blanks

• Commas (�)

• Periods (�)

• Plus signs (�)
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Description A description property field can be consist of from 1 to 50 characters.

 All keyboard characters are allowed except:

• Backslashes (?)

• Grave accent (C)

• Tilde (a)

• Double quotes (�)

• Pipe symbol (_)

• Asterisk (
)

• Question mark (")
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Call Center World objects

.........................................................................................................................................................................................................................................................
Overview

Purpose Objects include items on which you can perform actions in your Call 
Center World. For example, the objects may be vectors, trunk groups, or 
ACDs.

No matter which tool you use to select an object, the way in which you 
perform an action on the object is the same. 

In this section This section includes the following information:

• Defining Call Center World objects
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.........................................................................................................................................................................................................................................................
Defining Call Center World objects

Overview  The following list includes possible objects in your Call Center World. 
To perform actions on the object, click the object using the right mouse 
button.

• Call Center World object

• ScratchPad object

• CMS object

• ACD object

• Announcement Folder object

• Announcement object

• Split/Skill Folder object

• Split/Skill object

• Trunk Group Folder object

• Trunk Group object

• Vector Folder object

• Vector object

• VDN Folder object

• VDN object

Call Center World object The following table describes the Call Center World object:

Actions Description

Explore Expands your Call Center World to show one or more 
CMS Servers for which you have read or read and write 
permission.

Disconnect All Displays the Disconnect window with all connected 
CMS servers highlighted.

Navigator Launches the Navigator window with the Call Center 
World as the place to start browsing.

New If the CMS submenu is clicked, accesses the New CMS 
window to add a new server to your world.

Properties Displays the properties of your Call Center World.
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ScratchPad object The following table describes the ScratchPad object:

CMS object The following describes the CMS object:

ACD object The following table describes the ACD object:

Actions Description

Explore Expands the ScratchPad.

Navigator Launches the Navigator window with the ScratchPad as 
the place to start browsing.

New Creates a new ScratchPad or new vectors.

Cut Cuts the selected ScratchPad, to be pasted later.

Copy Copies an object, to be pasted later.

Paste Pastes an object that has been cut or copied.

Delete Deletes the ScratchPad. 

Rename Places the user in edit mode for the ScratchPad name 
field in the Renaming ScratchPad window.

Properties Displays the properties of the ScratchPad.

Actions Descriptions

Explore Expands the CMS object to show one or more ACDs for 
which you have read or read and write permission.

Connect Displays the Connect to server window for this CMS.

Disconnect Displays the Disconnect window with this CMS 
highlighted.

Navigator Launches the Navigator window with the CMS as the 
place to start browsing.

Delete Removes the CMS from your Call Center World.

Properties Displays the properties of the CMS.

Actions Descriptions

Explore Expands the ACD object to show folders of CMS 
entities.

Navigator Launches the Navigator window with the ACD as the 
place to start browsing.

Rename Places you in edit mode for the “ACD name” field in the 
Renaming ACD window.

Properties Displays properties of the ACD.
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Announcement Folder
object

The following table describes the Announcement Folder object:

Announcement object The following table describes the Announcement object:

Split/Skill Folder object The following table describes the Split/Skill Folder object:

Split/Skill object The following table describes the Split/Skill object:

Trunk Group Folder
object

The following describes the Trunk Group Folder object:

Actions Descriptions

Explore Expands the Announcement Folder.

Navigator Launches the Navigator window with the folder as the 
place to start browsing.

Properties Displays the properties of the Announcement folder.

Actions Descriptions

Navigator Launches the Navigator window with the announcement 
as the place to start browsing.

Rename Places the user in edit mode for the “Announcement 
name” field in the Renaming Announcement window.

Properties Displays the properties of the announcement.

Actions Descriptions

Explore Expands the Split/Skill Folder.

Navigator Launches the Navigator window with the folder as place 
to start browsing.

Properties Displays the properties of the Split/Skill Folder.

Actions Descriptions

Navigator Launches the Navigator window with the split/skill as the 
place to start browsing.

Rename Places user in edit mode for the “Split/Skill name” field 
in the Renaming Split/Skill window.

Properties Displays the properties of the Split/Skill.

Actions Descriptions

Explore Expands the Trunk Group Folder.

Navigator Launches the Navigator window with the folder as the 
place to start browsing.

Properties Displays the properties of the Trunk Group Folder.



  
Setting up your Call Center World CentreVu Visual Vectors User Guide

Defining Call Center World objects 2-24

Trunk Group object The following describes the Trunk Group object:

Vector Folder object The following table describes the Vector Folder object:

Vector object The following table describes the Vector object:

Actions Descriptions

Navigator Launches Navigator window with the trunk group as 
place to start browsing.

Rename Places the user in edit mode for the “Trunk Group name” 
field in the Renaming Trunk Group window.

Properties Displays the properties of the Trunk Group.

Actions Descriptions

Explore Expands the Vector Folder.

Navigator Launches the Navigator window with the folder as place 
to start browsing.

New Vector Creates a new vector with one Stop step in the folder.

Paste Pastes a vector if there is one cut or copied.

Properties Displays the properties of the Vector Folder.

Actions Descriptions

Edit Accesses the Vector Editor tool to edit the vector.

Export Accesses the Import Export Wizard to export the vector.

Navigator Launches the Navigator window with the vector as the 
place to start browsing.

Cut Copies a vector to memory and replaces it with a blank 
vector.

Copy Copies a vector to be pasted later.

Delete Deletes the vector from the folder for this ACD. This 
replaces it with a blank vector and leaves the name in the 
Dictionary.

Rename Places the user in edit mode for the “Vector name” field 
in the Renaming... window.

Properties Displays the properties of the vector.
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VDN Folder object The following table describes the VDN Folder object:

VDN object The following table describes the VDN object:

Actions Descriptions

Explore Expands the VDN folder.

Navigator Launches the Navigator window with the folder as the 
place to start browsing.

Properties Displays the properties of the VDN Folder.

Actions Descriptions

Navigator Launches the Navigator window with the VDN as the 
place to start browsing.

Rename Places the user in edit mode for the “VDN name” field in 
the Renaming VDN window.

Properties Displays the properties of the VDN.
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Call Center World object properties

.........................................................................................................................................................................................................................................................
Overview

Purpose Use object properties to change certain allowable parameters of:

• Any entities of the ACD, including announcements, splits or skills, 
trunk groups, VDNs, and vectors

• VDN administration, for example, its assigned vector and skill 
preferences

In this section This section includes the following information:

• Defining object properties
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.........................................................................................................................................................................................................................................................
Defining object properties

Overview The following table describes the properties of all objects in your Call 
Center World. To perform actions on the object, click the object using the 
right mouse button, and then select Properties.

• Call Center World object

• ScratchPad object

• CMS object

• ACD object

• Announcement Folder object

• Announcement object

• Split/Skill Folder object

• Split/Skill object

• Trunk Group Folder object

• Trunk Group object

• Vector Folder object

• Vector object

• VDN Folder object

• VDN object

Call Center World object The following table describes properties of the Call Center World object:

Properties Description

Name You cannot edit this name.

Type Type of object (World).

Permission Displays the permission (R for read) that you have for 
your Call Center World.

Description Description of the Call Center World. You can edit this 
field.
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ScratchPad object The following describes properties of the ScratchPad object:

CMS object The following describes properties of the CMS object:

ACD object The following table describes properties of the ACD object:

Properties Description

Name  Name of a folder that contains offline vectors.

Type Type of object (ScratchPad).

Permission Displays ScratchPad permissions (R for read and W for 
write).

Description Characters describing the ScratchPad object. You can 
edit this field.

Properties Description

Name Name of the CentreVu CMS server. You cannot edit this 
name.

Type Type of object (CMS or unconnected CMS).

Permission Displays the permissions (R for read, blank for none) that 
you have for the CentreVu CMS server.

Version If connected, displays CentreVu CMS server software 
release and version numbers, for example, R3V9.

Locale If connected, displays CentreVu CMS server software 
locale and time zone, for example, TZ GMT – 05:00.

Containee Count If connected, displays the number of objects (ACDs) that 
are contained within this object.

Properties Description

Name Name of the ACD in the CentreVu CMS Dictionary. You 
can rename it if you have ACD read and write access on 
the CMS.

Type Type of object (ACD).

Permission Displays the ACD permissions (read, write, or both) that 
you have on the CentreVu CMS.

Id Number that identifies the ACD on the CentreVu CMS.

Version DEFINITY server software release and version numbers, 
for example, ECS R9.

Locale DEFINITY server software locale and time zone, for 
example, TZ GMT — 05:00.
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Announcement Folder
object

The following table describes properties of the Announcement Folder 
object:

Announcement object The following describes properties of the Announcement object:

Link Status Status (Link Up, Link Down) of the link to the ACD 
from the CMS. The ACD icon is crossed out in the 
Navigator window if the link is down.

ACD Features Features enabled on the ACD, which could be EAS, 
Prompting, or Vectoring.

Description Description of the ACD in the CMS Dictionary. You can 
edit this field.

Properties Description

Properties Description

Name  Name of the folder that contains announcements for this 
ACD.

Type Type of object (folder).

Permission Displays the announcement permissions (read, write, or 
both), that you have for this ACD.

Containee Count Shows the number of announcements that are contained 
in the folder.

Properties Description

Name  Name of the announcement in the CMS Dictionary. You 
can rename it if you have read and write permissions. 

Type Type of object (announcement).

Permission Displays the permissions (read, write, or both) that you 
have for this announcement.

Extension Announcement extension number.

Description Description of the announcement in the CMS Dictionary. 
You can edit this field.
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Split/Skill Folder object The following describes properties of the Split/Skill Folder object:

Split/Skill object The following table describes properties of the Split/Skill object:

Trunk Group Folder
object

The following table describes properties of the Trunk Group Folder 
object:

Properties Description

Name  Name of the folder that contains measured splits or skills 
for this ACD.

Type Type of object (folder).

Permission Displays the split and skill permissions (read, write, or 
both) that you have for this ACD.

Containee Count Shows the number of splits or skills that are contained in 
the folder.

Properties Description

Name Name of the split/skill in the CentreVu CMS Dictionary.

Type Type of object (split/skill).

Permission Displays the permissions (read, write, or both) that you 
have for this split/ or skill.

Id Number identifying the split/skill on the CentreVu CMS.

Description Description of the split/skill in the CMS Dictionary. You 
can edit this field.

Properties Description

Name Name of the folder that contains measured trunk groups 
for this ACD.

Type Type of object (folder).

Permission Displays the trunk group permissions (read, write, or 
both) that you have for this ACD.

Containee Count Shows the number of trunk groups that are contained in 
the folder.
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Trunk Group object The following table describes properties of the Trunk Group object:

Vector Folder object The following table describes properties of the Vector Folder object:

Vector object The following table describes properties of the Vector object:

Properties Description

Name Name of the trunk group in the CentreVu CMS 
Dictionary.

Type Type of object (trunk group).

Permission Displays the permissions (read, write, or both) that you 
have for this trunk group.

Id Number that identifies the trunk group on the CentreVu 
CMS.

Description Description of the trunk group in the CMS Dictionary. 
You can edit this field.

Properties Description

Name Name of the folder that contains non-empty vectors for 
this ACD.

Type Type of object.

Permission Displays the vector permissions (read, write, or both) that 
you have for this ACD.

Containee Count Shows the number of vectors that are contained in the 
folder.

Properties Description

Name Name of the vector in the CentreVu CMS Dictionary.

Type Type of object (vector).

Permission Displays the permissions (read, write, or both) that you 
have for this vector

Description Description of the vector in the CMS Dictionary. You can 
edit this field.

Id Number that identifies the vector on the CentreVu CMS.

Step Count The number of steps that are contained in the vector.
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VDN Folder object The following table describes properties of the VDN Folder object:

VDN object The following table describes properties of the VDN object:

Properties Description

Name Name of the folder that contains measured VDNs for this 
ACD.

Type Type of object (folder).

Permission Displays the VDN permissions (read, write, or both) that 
you have for this ACD.

Containee Count Shows the number of VDNs that are contained in the 
folder.

Properties Description

Name Name of the VDN in the CentreVu CMS Dictionary.

Type Type of object (VDN).

Permission Displays the permissions (read, write, or both) that you 
have for this VDN.

Extension VDN extension number.

Vector Id Shows the number or synonym that identifies the vector 
that is assigned to this VDN. You can change this 
assignment if you have VDN permissions on the CMS 
for the ACD.

Description Description of the VDN in the CMS Dictionary. You can 
edit this field.

Skill Pref Shows what skill preferences are assigned to this VDN. 
You can change this assignment if you have VDN 
permissions on the CMS for the ACD [Expert Agent 
Selection (EAS) only].
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3 Using CentreVu Framework

.........................................................................................................................................................................................................................................................
Overview

Purpose This chapter explains how to use CentreVu Framework. It includes the 
following sections: 

• Introduction to CentreVu Framework

See the overview of each section for a preview of the section's contents.
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Introduction to CentreVu Framework

.........................................................................................................................................................................................................................................................
Overview

Purpose This section provides an introduction to CentreVu Framework features 
and explains how to use the Framework window.

In this section This section includes the following information:

• Features of CentreVu Framework

• Starting and exiting CentreVu Framework

• Framework window objects
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.........................................................................................................................................................................................................................................................
Features of CentreVu Framework

Introduction CentreVu Framework is the starting point of CentreVu Visual Vectors. 
CentreVu Framework gives you access to all of the CentreVu Visual 
Vectors features, which gives you the ability to manage any connections 
CentreVu Visual Vectors has to CentreVu Call Management System 
(CMS) servers. For example, from the CentreVu Framework window, you 
can access Visual Vectors tools to view, modify, add, and delete ACD 
items in the CentreVu CMS database.

After opening Framework, you can access and use the following tools:

• Navigator to view or modify the properties of objects in your Call 
Center World, which includes renaming some types of objects

• Vector Editor to create new vectors or edit existing ones

• VDN Assignment Wizard to assign one or more VDN(s) to a vector

• Import Export Wizard to import vectors to a public directory or other 
application

No matter which tool you use to select an operation, the way in which you 
perform the operation is the same. 
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.........................................................................................................................................................................................................................................................
Starting and exiting CentreVu Framework

Introduction This part explains how to start CentreVu Framework, how to log in to an 
existing or a new server, and how to exit CentreVu Framework and 
disconnect from the server.

Starting CentreVu
Framework

To start CentreVu Framework:

........................................................................................................................................................................

1 Select Start from the Microsoft Windows taskbar.

........................................................................................................................................................................

2 Select Programs from the Start menu.

........................................................................................................................................................................

3 Select the Avaya CentreVu Visual Vectors V9 program group.

........................................................................................................................................................................

4 Select CentreVu Visual Vectors V9.

The system starts the Visual Vectors program and opens the Framework 
window. Although Visual Vectors is running, you are not yet connected to 
a CMS server.

You may either connect to an existing server or establish a connection 
to a new server. You are limited to one instance of a login ID per 
server, but you can connect to more than one server at a time.

E N D  O F  S T E P S.................................................................................................................................................................................
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Logging in to an existing
server

Use this procedure if you have connected to a CMS server at least once.

........................................................................................................................................................................

1 Click Connect on the toolbar or select Connect from the File menu.

The system displays the Connect to Server dialog box showing the server 
to which you connected last.

........................................................................................................................................................................

2 If you want to connect to a different server than the one that is 
displayed, select a CMS server from the “Connect to server:” list.

........................................................................................................................................................................

3 Enter your CMS login Id in the Login Id: text box.

........................................................................................................................................................................

4 Enter your CMS password in the Password: text box. 
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........................................................................................................................................................................

5 Click Connect.

Result:  If the Disconnect toolbar button in CentreVu Framework is 
highlighted, you have successfully logged in to the CMS server.

E N D  O F  S T E P S.................................................................................................................................................................................

Logging in to a new
server

If you have never connected to a CMS server before, you need to establish 
a connection. To connect to a new server:

........................................................................................................................................................................

1 Select Connect from the File menu.

Result:  The system displays the New CMS login dialog box.

........................................................................................................................................................................

2 Type the hostname or IP address of a CentreVu CMS/Visual Vectors 
server in the Server Network Address: text box.

........................................................................................................................................................................

3 Enter your CentreVu CMS login ID in the Login Id: text box.
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........................................................................................................................................................................

4  Type your CMS password in the Password text box.

........................................................................................................................................................................

5 Click OK.

Result:  If the CMS server you entered exists, you are connected to 
this new server. If the CMS server does not exist, the system displays 
an error message showing the cause of the failure.

E N D  O F  S T E P S.................................................................................................................................................................................

Closing windows and
exiting

You do not have to close windows before exiting CentreVu Framework, 
but if you do not, the system displays a warning that you have open tools.

........................................................................................................................................................................

1 To close one or more CentreVu Framework windows, do one of the 
following:

• To close a window, click on the window to make it active and press 
Alt+F4. The active window closes.

• To close all windows, select Close All from the CentreVu 
Framework Window menu. All open windows close.

........................................................................................................................................................................

2 To exit CentreVu Framework, select Exit from the File menu.

If you have open windows other than the CentreVu Framework window, 
such as the Vector Editor or Navigator tools, the system displays a 
message asking if you want to exit.
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........................................................................................................................................................................

3 Click Yes to close the tools and exit CentreVu Framework.

If you restart CentreVu Framework, the system attempts to restore the 
windows you left open during the last session, and the system attempts to 
restore the CMS server connections that you used during the last session.

E N D  O F  S T E P S.................................................................................................................................................................................

Disconnecting from CMS
servers

You do not have to disconnect from CMS servers before exiting CentreVu 
Framework. The Visual Vectors program disconnects your computer 
automatically before it closes the CentreVu Framework window.

........................................................................................................................................................................

1 To disconnect from a server or servers, do one of the following:

• Select Disconnect from the CentreVu Framework File menu.

• Click Disconnect in the CentreVu Framework toolbar.

The system displays the Disconnect window.

........................................................................................................................................................................

2 Select the servers you want to disconnect from and then click 
Disconnect.

E N D  O F  S T E P S.................................................................................................................................................................................
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.........................................................................................................................................................................................................................................................
Framework window objects

Introduction This part introduces you to the features of the Framework window as they 
appear both before and after you connect to a CentreVu CMS server.

The following figure shows the CentreVu Framework window:

Title bar The title bar shows the name of the tool. When a vector is open in the 
Vector Editor, its name is shown.

Minimize, Maximize/
Restore, and Close

buttons

These buttons adjust the size of the current window, or close it. 

Toolbar The toolbar contains buttons for quick access to specific features of the 
application. When your mouse pointer is over a toolbar button for a few 
seconds, a brief description of the button displays. When you select a 
button, the status bar displays a description of the command that the 
particular button performs.

The following table describes buttons on the toolbar.

Button Function

Connect Initiates a connection to a CMS server.

Disconnect Disabled until you are connected to a CMS server.

Navigator Accesses the window for the Navigator. 

Vector Editor Accesses the window for the Vector Editor. 

VDN Assignment 
Wizard

Accesses the first of a series of dialog boxes for the VDN 
Assignment Wizard. 

Import Export 
Wizard

Accesses the first of a series of dialog boxes for the Import 
Export Wizard. 

CentreVu 
Supervisor

Starts CentreVu Supervisor Version 6 or later, if that program is 
installed correctly. If not, this button does not appear.

Help Contents Starts the Help application window for Visual Vectors. 
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Status bar The status bar is located at the bottom of the CentreVu Framework and 
Vector Editor windows. Framework displays a brief description of what 
actions are occurring. Vector Editor displays the number of steps in the 
current vector.

Menu bar The menu bar lists the available drop-down menus. This section identifies 
the menus that are available before you log in to the CMS server: File, 
Tools, Window, and Help.

File menu Select File from the menu bar to display the File menu.

File menu items

The File menu has the following items:

Connect  Displays the “Connect to server” window.

You can select from the drop-down list of servers to which you have 
previously connected, or click New CMS to identify a new server to log in 
to and add to your Call Center World.

Disconnect  Displays the Disconnect window that lists the servers to 
which you are connected.

Highlight the server or servers from which you wish to disconnect and 
select Disconnect or press Enter.

Exit  Automatically disconnects your computer from any CMS servers to 
which you are connected, and then closes the CentreVu Framework 
window. The system displays a warning message if you have open tool 
windows.
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Tools Menu Select Tools from the menu bar to display the Tools menu.

Tools menu items

The Tools menu has the following items:

Vector Editor  Opens the window for the Vector Editor. You can create 
new vectors or edit existing vectors in this window, and then save them to 
an ACD if you have the needed permissions or the ScratchPad on your 
computer.

Navigator  Opens the window for the Navigator. You can view, add, 
delete, or move objects in your Call Center World using this window.

VDN Assignment Wizard  Opens the first of a series of dialog boxes for 
the VDN Assignment Wizard. This tool helps you to assign VDNs to 
vectors and VDN skill preferences. You can also view which VDNs are 
assigned to which vectors and, if necessary, change those assignments.

Import Export Wizard  Opens the first of a series of dialog boxes for the 
Import Export Wizard. This tool helps you to create a vector file, which 
can contain one or more vector objects. You can then export the vector file 
to a shared or public directory, where it can be imported and shared by 
other users.

CentreVu Supervisor  Launches a separate session of CentreVu 
Supervisor. The two programs are autonomous. CentreVu Supervisor 
appears only if you have the right version installed on your computer.

Preferences...  Opens the Preferences window. You can view or modify 
settings such as Locale and indicate whether ToolTips are enabled.
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Advanced Debugging...  Used for debugging. Do not change the settings 
on the Advanced window unless you are instructed to do so by an Avaya 
administrator.

Window menu Select Window from the menu bar to display the Window menu.

Window menu items

The Window menu has the following items:

Close All  Closes the windows of all open tools, but leaves the CentreVu 
Framework window open and the Visual Vectors software running.

VDN Assignment Wizard  Makes the VDN Assignment Wizard the 
current window. 

Help menu Select Help from the menu bar to display the Help menu.

Press F1 or click Help to display help on a window or tool. 

Help menu items

In the Help menu, you can select from the following options:

Help Contents  Opens the Help window, and displays the Visual Vectors 
table of contents. 

About…  Displays the About CentreVu Visual Vectors… window, which 
shows the software build number. 
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4 Using Navigator 

.........................................................................................................................................................................................................................................................
Overview

Purpose This chapter explains how to use CentreVu Navigator. It includes the 
following sections:

• Introduction to Navigator

• Navigating your Call Center World

See the overview of each section for a description of the section's contents.
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Introduction to Navigator

.........................................................................................................................................................................................................................................................
Overview

Purpose This section provides an introduction to Navigator features and explains 
how to open and close Navigator. It also familiarizes you with the objects 
in the Navigator window.

In this section This section includes the following information:

• Features of Navigator

• Opening and closing Navigator

• Navigator window objects
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.........................................................................................................................................................................................................................................................
Features of Navigator

Introduction You use Navigator to view and manage call center objects using the same 
conventions as you use to manage Microsoft Windows Explorer. 
Navigator provides a means for you to:

• View and manage switch objects that are used in vectors

• Use the offline ScratchPad to store vectors on your computer. If you 
have many vectors, organize them into folders

• Copy and move vectors from ScratchPad to one or more ACDs, and 
between ACDs

• Change the properties of VDNs

• View and rename objects, depending on your permissions
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.........................................................................................................................................................................................................................................................
Opening and closing Navigator

Introduction This section explains how to open and close Navigator, how to log in to a 
CMS server, and how to disconnect your computer from any CMS servers 
to which you are connected.

Opening Navigator To open Navigator:

........................................................................................................................................................................

1 Select Start from the Microsoft Windows taskbar.

........................................................................................................................................................................

2 Select Programs from the Start menu.

........................................................................................................................................................................

3 Select the Avaya CentreVu Visual Vectors program group from the 
Programs submenu of the Start menu.

........................................................................................................................................................................

4 Select CentreVu Visual Vectors V9 from the program group.

Result:  The system starts the Visual Vectors program and opens the 
Framework window. Although Visual Vectors is running, you are not 
yet connected to a CMS server.

The following figure shows how Framework appears before you log 
in to a CMS server.
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........................................................................................................................................................................

5 Select Navigator from the Tools menu or click the Navigator icon on 
the toolbar.

Result:  The system displays the Navigator window. The Navigator 
window lists CMS servers to which you have connected before. If you 
want to view objects on a server, double-click the server name. If you 
are not connected to the server, Visual Vectors prompts you to log in.

E N D  O F  S T E P S.................................................................................................................................................................................

Logging in to an existing
server

This procedure explains how to log in to an existing server when you are 
working in Navigator.

........................................................................................................................................................................

1 If you double-click the name of a CMS server to which you are not 
connected, the system displays the Connect to server dialog box 
showing the server to which you are attempting to connect. 

........................................................................................................................................................................

2 If you want to connect to a different server than the one that is 
displayed, select a CMS server from the “Connect to server:” list.

........................................................................................................................................................................

3 Enter your CMS login Id in the Login Id: text box.
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........................................................................................................................................................................

4 Enter your CMS password in the Password: text box. 

........................................................................................................................................................................

5 Click Connect.

Result:  If the Disconnect toolbar button in CentreVu Framework is 
highlighted, you have successfully logged in to the CMS server.

E N D  O F  S T E P S.................................................................................................................................................................................

Logging in to a new
server

If you have never connected to a CMS server before, you need to establish 
a connection. To connect to a new server in Navigator:

........................................................................................................................................................................

1 Select New CMS from the File menu.

The system displays the New CMS login dialog box.

........................................................................................................................................................................

2 Type the hostname or IP address of a CentreVu CMS/Visual Vectors 
server in the Server Network Address: text box.
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........................................................................................................................................................................

3 Enter your CentreVu CMS login ID in the Login Id: text box.

........................................................................................................................................................................

4  Type your CMS password in the Password: text box.

........................................................................................................................................................................

5 Click OK.

Result:  If the CMS server you entered exists, you are connected to 
this new server. If the CMS server does not exist, the system displays 
an error message showing the cause of the failure.

E N D  O F  S T E P S.................................................................................................................................................................................

Closing Navigator and
exiting ........................................................................................................................................................................

1 To close Navigator, select Close from the Navigator File menu, or press 
Alt+F4.

........................................................................................................................................................................

2 To exit the software, select Exit from the File menu in the CentreVu 
Framework main window.

Result:  The Visual Vectors program automatically disconnects your 
computer from any CMS servers to which you are connected and then 
closes the CentreVu Framework window. 

........................................................................................................................................................................

3 If you have open windows other than the CentreVu Framework 
window, such as the Vector Editor or Navigator tools, and you try to 
exit, the system displays a message asking if you want to exit. Click 
Yes to disconnect and exit.

If you restart CentreVu Framework, the system attempts to restore the 
windows you left open during the last session, and the system attempts to 
restore the CMS server connections that you used during the last session.

E N D  O F  S T E P S.................................................................................................................................................................................
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.........................................................................................................................................................................................................................................................
Navigator window objects

Introduction This section introduces you to the features of the Navigator window as 
they appear both before and after you connect to a CentreVu CMS server.

The following figure shows the Navigator window:

System menu box The system menu box enables you to perform operations such as closing 
the current window or application. 

Title bar The title bar shows the name of the application. 

Maximize, minimize and
close buttons

The buttons in the upper right corner that adjust the size of the current 
window or close it. 

Toolbar The toolbar contains buttons for quick access to specific features of the 
application. When your mouse pointer is over a toolbar button for a few 
seconds, a brief description of the button displays. When you select a 
button, the status bar displays a description of the command that the 
particular button performs

The following table describes buttons on the toolbar: 

Button Function

Up One Level Highlights the parent object of the selected object in the 
left pane and displays the parent object’s contents in the 
right pane.
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Status indicators The following table describes the indicators in Navigator. These 
indicators tell you about the state of a CMS server and its measured 
ACDs.

New Creates a new object on the CMS server (or your 
computer’s ScratchPad).

Delete Removes an object from the CMS server (or your 
computer’s ScratchPad).

Rename Opens the Renaming Object window and enters the 
editing mode for the name of the selected object.

Properties Opens the Properties window for the selected object.

Undo Restores the last action that was performed in this 
Navigator session, up to four previous actions.

Redo Restores the last action that was undone in this Navigator 
session, up to four previous actions.

Cut Removes the selected object to be pasted later.

Copy Makes a copy of the selected object and saves it to be 
pasted later.

Paste Pastes the object that was previously cut or copied.

Details Changes the information displayed in the right pane for 
objects that are selected in the left pane. Details view is 
the default, showing one row for each object that is 
contained in the object selected in the left pane. Each row 
contains columns for the object’s Name, Number, Type, 
and your read or write Permissions for it.

List Changes the information that is displayed in the right 
pane for objects that are selected in the left pane. List 
view shows one named icon for each object that is 
contained in the object selected in the left pane.

Help Contents Opens the Help Topics window and displays the table of 
contents. 

Button Function

This indicator Displays

Login status The icon for the CMS object in Navigator displays a 
black screen if you are not connected.
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Status messages The following table describes the status messages that may display in 
Visual Vectors.

Menu bar The menu bar identifies the four menus that are available after you log in 
to a CMS server: File, Edit, View, and Help.

File menu The following figure shows the file menu in the Navigator window:

ACD link status Icons for the ACDs that are supported by the CMS. If the 
link to an ACD is down, the icon is crossed out. If the 
CMS server is connected to the ACD via a TCP/IP 
connection and the connection is in a transient state, the 
icon changes to a straight line.

This indicator Displays

This message Displays when

Starting tool... A Visual Vectors window is opening. Framework is 
locked during this time. 

Looking for items 
to Connect...

Framework is searching your Call Center World for CMS 
servers. 
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File menu items The File menu has the following items.

New  Creates a new object on the CMS server or your computer’s 
ScratchPad.

Delete  Removes an object from the CMS server or your computer’s 
ScratchPad.

Rename  Shows the Renaming Object window and enters the editing 
mode for the name of the selected object.

Properties  Accesses the Properties window for the selected object.

Close  Closes the Navigator window.

Edit menu The following figure shows the Edit menu in the Navigator window:

Edit menu items The Edit menu has the following items.

Undo  Restores the last action performed in this Navigator session, up to 
four previous actions.

Redo  Restores the last Undo that was performed in this Navigator 
session, up to four previous actions.

Cut  Removes the selected object and saves it to be pasted later.

Copy  Makes a copy of the selected object to be pasted later.

Paste  Pastes an object that was previously cut or copied.
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View menu The following figure show the view menu in the Navigator window:

View menu items The View menu has the following items.

Up One Level  Highlights the parent object of the selected object in the 
left pane, and displays the parent object’s contents in the right pane.

Details  Changes the information that is displayed in the right pane for the 
objects that are selected in the left pane. Details view is the default, and it 
shows one row for each object that is contained in the object selected in 
the left pane. Each row contains columns for the object’s name, its type, 
and your read or write permissions for it.

List  Changes the information that is displayed in the right pane for 
objects that are selected in the left pane. List view shows one named icon 
for each object that is contained in the object selected in the left pane.

Refresh  Refreshes and redraws both panes of the Navigator window.
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Help menu The following figure shows the Help menu in the Navigator window:

Help menu items Press F1 or click Help to display context-sensitive help. Select Help from 
the menu bar to choose from the following items. 

Help Contents  Opens the Help Topics window and displays the table of 
contents.

About…  Opens the About… window, which shows the software version 
number. 
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Navigating your Call Center World

.........................................................................................................................................................................................................................................................
Overview

Purpose Use this section to learn how to view and manage call center objects.

In this section This section includes the following information:

• Managing call center objects

Related information The objects that are visible in Navigator windows have sets of:

• Actions that you can perform on them. See Call Center World 
objects for more information.

• Properties, some of which may be modified. See Changing object 
properties (4-17) for more information.
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.........................................................................................................................................................................................................................................................
Managing call center objects

Introduction Follow the instructions to explore objects, make menu selections, add 
objects, change object properties, and enter values in input fields.

Exploring objects To explore an object, browse your Call Center World to find:

• Any entities of the ACD, including announcements, splits or skills, 
trunk groups, VDNs, and vectors

• VDN administration, including the vector and skill preferences 
assigned to one or more VDNs

To explore an object, do any of the following: 

• Click the “+” icon next to an object, for example, a CMS, to expand 
the display and show objects contained by that object, for example, 
ACDs.

• If you need to reduce clutter, click the “–” icon to the left of an object 
to collapse the display and hide the objects within that object.

• Double-click an object to perform the default function of that object.

For example, double-click a container to explore the container. 
However, if you double-click a vector, you go directly to editing the 
selected vector.

• Highlight an object and right-click it to display the object's shortcut 
menu. The shortcut menu displays the allowable actions.

Selecting menu items To select a Navigator menu item, choose any of the following methods:

• Click the item.

• Use the arrow keys to highlight the item and then press Enter.

• Press Alt and press the underlined letter in the menu or item that you 
want to select

• Hold down Ctrl and press the accelerator key assigned to the action. 
For example, use Ctrl+C to copy. 
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Adding a new object To add a new object in Navigator:

........................................................................................................................................................................

1 In the Framework window, select Navigator from the Tools menu, or 
click the Navigator icon in the toolbar.

The Navigator window opens.

........................................................................................................................................................................

2 From the File menu in Navigator, or by using the Navigator toolbar, 
select New to add an object.

If you select:

• New CMS, the New CMS Server window opens for you to specify 
the parameters of a new server.

• New ScratchPad, the New ScratchPad window opens for you to 
specify the name of a new offline folder.

• New Vector, the New Vector window opens for you to specify the 
name. This feature can create a new online vector that contains one 
Stop step or an empty offline vector.

........................................................................................................................................................................

3 Complete entries on the New, Rename, or Properties window (as 
applicable) and click OK.

To rename an object, you must have Write permission.

E N D  O F  S T E P S.................................................................................................................................................................................
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Copying, deleting, and
renaming objects

To copy, delete, or rename an object in Navigator:

........................................................................................................................................................................

1 In the Framework window, select Navigator from the Tools menu, or 
click the Navigator icon in the toolbar.

Result:  The Navigator window opens.

........................................................................................................................................................................

2 From the File menu in Navigator, or by using the Navigator toolbar, 
select:

• Copy to copy a selected object. You can then paste it into an 
allowable container.

• Delete to remove the selected object.

• Rename to change an object's name. The Rename object window 
opens with the object's name highlighted for editing.

........................................................................................................................................................................

3 Complete entries on the Copy, Delete, or Rename window (as 
applicable) and click OK.

E N D  O F  S T E P S.................................................................................................................................................................................

Changing object
properties

To change the properties of an object in Navigator:

........................................................................................................................................................................

1 In the Framework window, select Navigator from the Tools menu, or 
click the Navigator icon in the toolbar.

The Navigator window opens.
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........................................................................................................................................................................

2 From the File menu in Navigator, or by using the Navigator toolbar, 
select Properties. The Properties window for the selected object opens.

Example:  A Properties window for an Import Export object is shown 
below.

........................................................................................................................................................................

3 Enter the information in the field or fields you want to edit. You can 
complete an input field in a Properties window by:

• Entering the requested information in the text box

• Selecting the information from a drop-down list of valid entries

• Checking a box for the input field

 You can edit some fields, while others are for display only.

........................................................................................................................................................................

4 When you are finished, click OK.

Important! If you need to know what properties an object has, see 
Defining object properties.

E N D  O F  S T E P S.................................................................................................................................................................................
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5 Using the Vector Editor

.........................................................................................................................................................................................................................................................
Overview

Purpose  This chapter explains how to use the Vector Editor. It includes the following 
sections:

• Introduction to the Vector Editor

• Using Vector Editor windows

• Using vector steps

See the overview of each section for a description of the section's contents.
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Introduction to the Vector Editor

.........................................................................................................................................................................................................................................................
Overview

Purpose This section provides an overview of the Visual Vectors Vector Editor. It 
also explains how to open the Vector Editor, close windows, and exit the 
Vector Editor.

In this section This section includes the following information:

• Vector Editor features

• Opening and closing the Vector Editor

• Vector Editor window objects
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.........................................................................................................................................................................................................................................................
Vector Editor features

Introduction Visual Vectors’ Vector Editor allows you to create and edit vectors using a 
graphical user interface (GUI) that lets you drag and drop icons from a 
palette and arrange them into vector steps in a work area. The Vector 
Editor lets you:

• Create and edit vectors by an easy, drag-and-drop method

• Annotate, that is, attach comments to vectors

• Print representations of vectors

Note that Navigator supplies a read-only plain text view of vectors for 
users who are familiar with accessing vectors from a terminal.
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.........................................................................................................................................................................................................................................................
Opening and closing the Vector Editor

Opening the Vector
Editor

This section explains how to open the Vector Editor.

Procedure To open the Vector Editor:

........................................................................................................................................................................

1 Select Start from the taskbar.

........................................................................................................................................................................

2 Select Programs from the Start menu.

........................................................................................................................................................................

3 Select the Avaya CentreVu Visual Vectors 9 program group.

........................................................................................................................................................................

4 Select CentreVu Visual Vectors 9.

The system starts the Visual Vectors program and opens the Framework 
window. Although Visual Vectors is running, you are not yet connected to 
a CMS server.

The following figure illustrates how the main window appears before you 
log in to a CMS server.
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........................................................................................................................................................................

5 To start the Vector Editor, do one of the following:

• Select Vector Editor from the Tools menu.

• Click the Vector Editor icon in the toolbar.

The system displays the Vector Editor menu.

........................................................................................................................................................................

6 Select the type of Vector you want from the Vector Editor menu.

You can also double-click on a vector in Navigator to start the Vector 
Editor.

E N D  O F  S T E P S.................................................................................................................................................................................
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.........................................................................................................................................................................................................................................................
Closing the Vector Editor

Closing Vector Editor
windows

To close one Vector Editor window, do one of the following:

• Select Close from the Vector Editor File menu.

• Press Alt+F4 while the window is active.

• Select Close from the CentreVu Framework Window menu and then 
select the window you want to close from the drop-down menu.

To close all windows, select Close All from the CentreVu Framework 
Window menu.

If you have unsaved changes to the current vector, the system asks you if 
you want to save them.

For information on exiting the Vector Editor, see Closing windows and 
exiting (3-7).
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.........................................................................................................................................................................................................................................................
Vector Editor window objects

Introduction Using the Vector Editor window, you can create and edit vectors visually 
using common Windows-based conventions. For example, you can use 
the drag-and-drop method to move icons that represent commands from a 
palette and arrange them into vector steps in a work area. You can also 
attach comments, change layout, and save and print the vectors.

The following figure shows the Vector Editor window:

System menu box The system menu box enables you to perform operations such as closing 
the current window or application.

Title bar The title bar shows the name of the application. 

Minimize, maximize and
close buttons

These buttons in the upper right corner of the window adjust the size of 
the current window or close it.

Toolbar The toolbar contains buttons for quick access to specific features of the 
application. When your mouse pointer is over a toolbar button for a few 



  
Using the Vector Editor CentreVu Visual Vectors User Guide

Vector Editor window objects 5-8

seconds, a brief description of the button displays. When you select a 
button, the status bar displays a description of the command that the 
particular button performs.

The following table describes buttons on the toolbar:

Button Function

New Creates a new vector in memory.

Open... Displays the Select the Vector to open window. Use this 
window to browse your Call Center World to find the 
vector you want to work with.

Save Copies (saves) the vector you are working on to the CMS 
Server (or computer ScratchPad) where the original vector 
that you opened resides.

Print... Displays the standard Windows Print window.

Cut Removes whatever you select and saves it to be pasted later.

Copy Makes a copy of whatever you select and saves it to be 
pasted later.

Paste Pastes the selection that was previously cut or copied.

Delete Removes the object you select from the vector.

Undo Restores the last action that was performed in this Vector 
Editor session. There are no limits to the number of actions 
you can undo in Vector Editor.

Redo Restores the last action that was undone in this Vector 
Editor session. There are no limits to the number of actions 
you can redo in Vector Editor.

Zoom In Magnifies the vector display each time it is selected.

Zoom Out Decreases the magnification of the vector display each time 
it is selected.

Help Contents Opens the Help Topics window, and displays the table of 
contents. 
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Status indicators The following table describes status indicators:

Menu bar The menu bar lists the available drop-down menus. The following 
information identifies these menus: File, Edit, View, Insert, and Help.

File menu The following figure shows the File menu in the Vector Editor window:

Indicator Function

Vector 
Location

Shows New Vector or a full path to an existing vector in 
your Call Center World (for example, /Call Center World/
CMS20/ACD8/Vector Folder/Visual Vector).

Current Visual 
Steps 

Shows a count of the number of palette icons in the current 
visual vector. The initial Start icon is not counted.

Current Stored 
Steps 

Shows a count of the number of vector steps the current 
vector will occupy when stored on an ACD. The limit is 32 
steps. At step 29, the line stating the number of steps turns 
yellow. At step 33, the line turns red.
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File menu items  The File menu has the following items:

New  Creates a new vector in memory.

Open...  Displays the Select the Vector to open window, allowing you to 
browse your Call Center World to find the vector that you want to work 
with.

Save  Saves your vector.

Save As...  Displays the Save Vector As window.

Print...  Displays the standard Windows Print window.

Properties  Accesses the Properties window for the current vector.

Close  Closes the Vector Editor tool’s window.

Edit menu The following figure shows the Edit menu in the Vector Editor window:
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Edit menu items The Edit menu has the following items: 

Undo  Restores the last action that was performed in this Vector Editor 
session. There are no limits to the number of actions you can undo in 
Vector Editor.

Redo  Restores the last action that was undone in this Vector Editor 
session. There are no limits to the number of actions you can redo in 
Vector Editor.

Cut  Removes whatever you selected and saves it to be pasted later.

Copy  Makes a copy of your selection and saves it to be pasted later.

Select All  Selects all steps in the vector.

Paste  Pastes the selection that was previously cut or copied.

Delete  Removes whatever you selected from the vector.

View menu The following figure shows the View menu in the Vector Editor window:
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View menu items The View menu has the following items: 

Toolbar  Toggles to show the Vector Editor toolbar.

 View Comments  Toggles to show the comments for the vector steps.

View Labels  Toggles to show the labels for the vector steps.

Layout...  Displays a window that you can use to change how vectors are 
laid out or oriented.

Reset Zoom  Resets the zoom magnification to the default of 100%.

Zoom In  Magnifies the vector display each time that it is selected.

Zoom Out  Decreases the magnification of the vector display each time 
that it is selected.

Insert menu The following figure shows the Insert menu in the Vector Editor window:
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Insert menu item The Insert menu has the following item.

Comments  Allows you to type comments and attach them to a visual 
vector. If you use a tool other than the Vector Editor to edit vectors, then 
your comments will be detached from the vector steps and you will have 
to reattach them.

Help menu The following figure shows the Help menu window:

Help menu items Press F1 or click Help to display context-sensitive help. Select Help from 
the menu bar to choose from the following:

Help Contents  Opens the Help Topics window and displays the table of 
contents.

About…  Opens the About… window, which shows the software version 
number. 
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Using Vector Editor windows

.........................................................................................................................................................................................................................................................
Overview 

Purpose This section introduces you to the features of the Vector Editor window. 
Follow the instructions to select menu items and enter values in input 
fields in Vector Editor dialog boxes.

In this section This section includes the following information:

• Accessing vectors

• Saving and printing vectors
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.........................................................................................................................................................................................................................................................
Accessing vectors

Procedure You can access vectors from the Navigator window or from the Vector 
Editor. 

Accessing vectors from
Navigator

To access vectors from the Navigator window:

........................................................................................................................................................................

1 In the CentreVu Framework window, select Navigator from the Tools 
menu, or click the Navigator icon in the toolbar.

The system displays the Navigator window.

........................................................................................................................................................................

2 Browse your Call Center World to find the object you want. See 
Exploring objects (4-15).
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........................................................................................................................................................................

3 When you find the object you want, such as the ScratchPad or an 
ACD’s Vector Folder in the Navigator window, double-click it to open 
it. The objects contained in the folder appear in the right pane of the 
Navigator window. 

In the example below, the objects in the Bull_R8vpe ACD’s Vector Folder 
are listed in the right pane.
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........................................................................................................................................................................

4 Double-click the vector, for example, QFA Import Export A, to open it.

The Vector Editor opens the vector.

E N D  O F  S T E P S.................................................................................................................................................................................
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Accessing vectors from
Vector Editor

To access a vector from the Vector Editor window:

........................................................................................................................................................................

1 Select Open... from the Vector Editor File menu.

The system displays the Select the Vector to open window.

........................................................................................................................................................................

2 Browse your Call Center World to find the vector you want to open. 
See Exploring objects (4-15).
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........................................................................................................................................................................

3 Click the name of the vector you want to open.

In the example below, the QFA Import Export A vector is selected.

........................................................................................................................................................................

4 Click Open.

Result:  The Vector Editor opens the vector.

E N D  O F  S T E P S.................................................................................................................................................................................
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.........................................................................................................................................................................................................................................................
Saving and printing vectors

Introduction This procedure explains how to save and print vectors from the Vector 
Editor and from Navigator.

Saving vectors To save a vector from the Vector Editor window:

........................................................................................................................................................................

1 Select Save As... from the File menu.

Result:  The Vector Editor displays the Save Vector As window.

........................................................................................................................................................................

2 Browse your Call Center World to find the container in which you want 
to save the current vector. See Exploring objects (4-15).
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........................................................................................................................................................................

3 Click the name of the container (ScratchPad or Vector Folder) in which 
you want to save the vector.

........................................................................................................................................................................

4 If you want to give the vector a name that is different from the default 
name, type your preferred name in the Name text box.

........................................................................................................................................................................

5 Click Save.

Result:  The Vector Editor does one of the following:

• Saves a graphical representation of the selected vector to the 
ScratchPad

• Converts the visual vector and stores it on the ACD containing 
the Vector Folder

E N D  O F  S T E P S.................................................................................................................................................................................

In Navigator

Alternatively, in Navigator you can drag and drop vectors into the 
container in which you want to save them.

Printing vector graphics The print function is available only in the Vector Editor module of Visual 
Vectors. To print a vector graphic:

........................................................................................................................................................................

1 Select Print from the File menu in the Vector Editor window. The 
system displays the Print dialog box.

........................................................................................................................................................................

2 In the Print dialog box, select the printer, print range, and number of 
copies.

........................................................................................................................................................................

3 If you need to specify any printer properties, click Properties and make 
your changes in the Document Properties window. Then click OK.
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........................................................................................................................................................................

4 In the Print dialog box, click OK.

Result:  The system displays the Printing Properties window.
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........................................................................................................................................................................

5 The Printing Properties window lets you scale your printed graphic. 
Select any of the following print options:

• 1 to 1: Your vector graphic will print as the size you see on your 
screen. This is the default option.

• fits to 1 page: Your vector graphic will print on one page.

• fits to width - pages: Your vector graphic will print on the number of 
pages you specify in the pages field. The printed graphic will remain 
height and width proportional.

• fits to height - pages: Your vector graphic will print on the number of 
pages you specify in the pages field. The printed graphic will remain 
height and width proportional.

• resize to %: Your vector graphic will print to the size you specify in 
the % field. The printed graphic will remain height and width 
proportional.

• Step Labels: Click to enable the printing of step labels that are 
present on your vector graphic. If there are no step labels, this field is 
unavailable.

• Floating Comments: Click to enable the printing of global comments 
that are present on your vector graphic. If there are no step 
comments, this field is unavailable.

• Alignment: Allows you to determine the positioning of the vector 
graphic on the printout.

........................................................................................................................................................................

6 Click OK in the Printing Properties window to print your vector 
graphic.

E N D  O F  S T E P S.................................................................................................................................................................................
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Using vector steps

.........................................................................................................................................................................................................................................................
Overview 

Purpose This section lists the vector steps in the Vector Editor palettes and 
describes all possible step properties.

In this section This section includes the following information:

• Vector step palettes

• Vector step properties

• Creating a new Goto vector

• Moving or copying vectors to ACDs of different types
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.........................................................................................................................................................................................................................................................
Vector step palettes

Introduction Vector steps are grouped in the following five palettes on the left side of 
the Vector Editor window. Note that not all the steps are available for 
every type of vector. For example, the collect step is not available for non 
prompting vectors.

• Input/Output

– Announcement

– Timed Announcement

– Music

– Ringback

– Silence

– Reply

– Consider

– Collect

– Converse

• End

– Busy

– Stop

– Disconnect

• Test

– Caller Info

– Center Info

– Queue Activity

– Agent Activity

– Time of Day

– Holiday

• Queue

– Queue Activity

– Center Info

– Agent Activity

– Queue Unconditional
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• Routing

– Route To Number

– Route To Digits

– Adjunct Route

– Messaging Skill

– Goto Vector.
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.........................................................................................................................................................................................................................................................
Vector step properties

Overview When you select properties from the shortcut menu for an object, the 
system displays an input window. The information that is required in the 
input window depends on the object.

This section describes all possible properties. However, not all features 
automatically show. Which properties are shown, which menu items are 
available, and which toolbar buttons function can vary from user to user.

The tables in this section state that you can have as many as 999 Skill Ids. 
This is true for CentreVu CMS R3V8 or later vectors. However, CentreVu 
CMS R3V6 vectors can still only have a maximum of 600 vectors.

The following are described:

• Basic features of fields on property windows

• Properties of the Announcement (Input/Output) step

• Properties of the Timed Announcement (Input/Output) step

• Properties of the Music (Input/Output) step

• Properties of the Ringback (Input/Output) step

• Properties of the Silence (Input/Output) step

• Properties of the Reply (Input/Output) step

• Properties of the Consider (Input/Output) step

• Properties of the Collect (Input/Output) step

• Properties of the Converse (Input/Output) step

• Properties of the Busy (End) step

• Properties of the Stop (End) step

• Properties of the Disconnect (End) step

• Properties of the Caller Info (Test) step

• Properties of the Center Info (Test) step

• Properties of the Queue Activity (Test) step

• Properties of the Agent Activity (Test) step

• Properties of the Time Of Day (Test) step

• Properties of the Holiday (Test) step

• Properties of the Queue Activity (Queue) step

• Properties of the Center Info (Queue) step

• Properties of the Agent Activity (Queue) step
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• Properties of the Queue Unconditional (Queue) step

• Properties of the Route To Number (Routing) step

• Properties of the Route To Digits (Routing) step

• Properties of the Adjunct Route (Routing) step

• Properties of the Messaging Skill (Routing) step

• Properties of the Goto Vector (Routing) step

Basic features of fields
on property windows

Use the features of the Property window to enter or edit existing field 
values, as shown in the following table:

Announcement (Input/
Output) step

The following table describes the Announcement (Input/Output) step:

Feature Action

Text boxes Type in any characters from the keyboard for this field.

Drop-down 
lists

View and select from a list of the valid values for this input 
field.

Numeric 
fields

Type in numbers (depending on switch type and software 
version) for this input field.

Check Boxes Select the check box to toggle it on for yes or off for no.

Properties Description

Announcement Select a valid announcement for the ACD on which the 
step will be saved, or select Extension.

Extension Enter an extension number of from 1 to 5 digits 
(default=0). Disabled if Announcement is not tied to an 
Extension.

Comment Enter a comment that is associated with this step.
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Timed Announcement
(Input/Output) step

The following table describes the Timed Announcement (Input/Output) 
step:

Music (Input/Output)
step

The following table describes the Music (Input/Output) step:

Ringback (Input/Output)
step

The following table describes the Ringback (Input/Output) step:

Silence (Input/Output)
step

The following table describes the Silence (Input/Output) step:

Reply (Input/Output) step The following table describes the Reply (Input/Output) step:

Properties Description

Seconds Enter a numeric value from 0 to 999 (default=0).

Announcement Select a valid announcement for the ACD in which the 
step will be saved, or select Extension.

Extension Enter an extension number of from 1 to 5 digits 
(default=0). Disabled if Announcement is not tied to an 
Extension.

Treatment Select music, silence, ringback, or continue. The default 
is continue.

Comment Enter a comment that is associated with this step.

Properties Description

Seconds Enter a numeric value from 0 to 999 (default=0).

Comment Enter a comment that is associated with this step.

Properties Description

Seconds Enter a numeric value from 0 to 999 (default=0).

Comment Enter a comment that is associated with this step.

Properties Description

Seconds Enter a numeric value from 0 to 999 (default=0).

I-Silent Select to enable the I-Silent feature.

Comment Enter a comment that is associated with this step.

Properties Description

Comment Enter a comment that is associated with this step.
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Consider (Input/Output)
step

The following table describes the Consider (Input/Output) step:

Collect (Input/Output)
step

The following table describes the Collect (Input/Output) step:

Properties Description

Measure Split/Skill is the default value. Select a location from the 
drop-down list, if applicable.

Split/Skill Select a split, skill, or ID (or First, Second, or Third if 
EAS) from the drop-down list. This field is disabled if the 
value in the Measure field is Location.

Skill Id Enter a numeric value from 1 to 999 (default=1). This 
field is disabled if the value in the Measure field is 
Location or if the Split/Skill field is not Id.

Priority High is the default, or select low, medium, or top from the 
drop-down list. This field is disabled if the value in the 
Measure field is Location.

Location Enter a numeric value from 1 to 255 (default=1). This 
field is disabled if the value in the Measure field is Split/
Skill.

Adjustment Enter a numeric value from 0 to 100 (default=0).

Comment Enter a comment that is associated with this step.

Properties Description

Source Digits is the default, or select CED or CDPD from the 
drop-down list, if applicable.

Number of digits Enter a numeric value from 1 to 16 (default=1). This field 
is disabled if the Source field is not digits.

Comment Enter a comment that is associated with this step.
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Converse (Input/Output)
step

The following table describes the Converse (Input/Output) step:

Busy (End) step The following table describes the Busy (End) step:

Stop (End) step The following table describes the Stop (End) step:

Disconnect (End) step The following table describes the Disconnect (End) step:

Properties Description

Split/Skill Select a split/skill (First, Second, Third or Id) from the 
drop-down list. 

Skill Id Enter a numeric value from 1 to 999 (default=1). This 
field is disabled if the value in the Split/Skill field is not 
Id.

Priority High is the default, or select low, medium, or top from the 
drop-down list.

Passing None is the default, or select vdn, ani, digits, qpos, wait, 
or data from the drop-down list.

Data Enter up to a 6-digit number, if applicable (default is 
blank). This field is enabled only if the value in the first 
Passing field is Data.

Passing None is the default value. Select vdn, ani, digits, qpos, 
wait, or data from drop-down list. If the first Passing field 
value is None, then the only valid value for this second 
Passing property is None.

Data Enter up to a 6-digit number, if applicable (the default is 
blank). This field is enabled if the value in the second 
Passing field is Data.

Comment Enter a comment that is associated with this step.

Properties Description

Comment Enter a comment that is associated with this step.

Properties Description

Comment Enter a comment that is associated with this step.

Properties Description

Comment Enter a comment that is associated with this step.
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Caller Info (Test) step The following table describes the Caller Info (Test) step:

Center Info (Test) step The following table describes the Center Info (Test) step:

Properties Description

Measure ANI is the default, or select digits or ii-digits from the 
drop-down list, if applicable.

Comparator Equals (=) is the default, or select <=, <>, <, >, >=, in, or 
not in, from the drop-down list.

Threshold Null is the default, or enter a numeric value of 1 to 16 
characters if ani or digits, 00 to 99 if ii-digits (?, +, and # 
are valid in certain situations). This field is enabled only 
if the value in the Comparator field is in or not in.

Table Zero (0) is the default, or enter a numeric value from 1 to 
100. This field is disabled if the value in the Comparator 
field is anything except in or not in.

Comment Enter a comment that is associated with this step.

Properties Description

Measure Counted-calls to VDN is the default, or select rolling-asa or 
expected-wait from the drop-down list.

Split/Skill Select a split/skill (First, Second, Third, Best, Call, or Id) from the 
drop-down list. This field is disabled if the value in the Measure 
field is not expected wait.

Skill Id Enter numeric value from 1 to 999 (default=0). This field is 
disabled if the value in the Split/Skill field is not Id.

Priority High is the default, or select low, medium, or top from the drop-
down list. This field is disabled if the value in the Measure field is 
not expected wait, or if the value in the Split/Skill field is Best or 
Call.

VDN Select a VDN (or extension, active, or latest) from the drop-down 
list. This field is disabled if the value in the Measure field is 
expected wait.

Extension Enter an extension number of from 1 to 5 digits. This field is 
disabled if the value in the VDN field is not an extension.

Comparator Equals (=) is the default value. Select <=, <>, <, >, >=, from the 
drop-down list.

Threshold One (1) is the default value, or enter a numeric value that depends 
on the Measure and the software version of your switch.

Comment Enter a comment that is associated with this step.
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Queue Activity (Test)
step

The following table describes the Queue Activity (Test) step:

Agent Activity (Test) step The following table describes the Agent Activity (Test) step:

Properties Description

Measure Rolling-asa is the default value. Select calls-queued, 
interflow-qpos, oldest-call-wait, or wait-improved from 
the drop-down list.

Split/Skill Select a split/skill (First, Second, Third, Id, or Best) from 
the drop-down list. Disabled if Measure is interflow-qpos. 
Best is invalid if Measure is anything but wait-improved.

Skill Id Enter a numeric value from 1-999 (default=1). This field 
is disabled if the value in the Split/Skill field is not Id. If 
you are in working offline (for example, in a ScratchPad 
vector), you can also enter synonyms, but once you go 
online you can only use numbers.

Priority High is the default, or select low, medium, or top from the 
drop-down list. This field is disabled if the value in the 
Measure field is interflow-qpos.

Comparator Equals (=) is the default, or select <=, <>, <, >, >=, from 
the drop-down list.

Threshold One (1) is the default, or enter a numeric value that 
depends on Measure and the software version of your 
switch.

Comment Enter a comment associated with this step.

Properties Description

Measure Available-agents is the default, or select staffed-agents 
from the drop-down list.

Split/Skill Select a split/skill (First, Second, Third, or Id) from the 
drop-down list.

Skill Id Enter a numeric value from 1 to 999 (default=0). This 
field is disabled if the value in the Split/Skill field is not 
Id.

Comparator Equals (=) is the default, or select <=, <>, <, >, >=, from 
the drop-down list.

Threshold Zero (0) is the default value, or enter a numeric value that 
depends on Comparator and the software version of your 
switch.

Comment Enter a comment associated with this step.
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Time Of Day (Test) step The following table describes the Time Of Day (Test) step:

Holiday (Test) step The following table describes the Holiday (Test) step:

Queue Activity (Queue)
step

The following table describes the Queue Activity (Queue) step:

Properties Description

Start Day All is the default, or select beginning day from the drop-
down list. Must select All if Finish Day is All.

Start Time Current time is the default, or enter the beginning time of 
day in 24-hour format.

Finish Day All is the default, or select the ending day from the drop-
down list. Must select All if Start Day is All.

Finish Time Current time is the default, or enter the ending time of day 
in 24-hour format.

Comment Enter a comment associated with this step.

Properties Description

Comparator In is the default, or select not-in from the drop-down list.

Table Zero (0) is the default, or enter a numeric value from 1–
10.

Comment Enter a comment associated with this step.

Properties Description

Measure Rolling-asa is the default, or select calls-queued, oldest-
call-wait, or wait-improved from the drop-down list.

Split/Skill Select a split/skill (First, Second, Third, Id, or Best) from 
the drop-down list. Best is valid only if Measure is wait-
improved.

Skill Id Enter a numeric value from 1 to 999 (default=1). This 
field is disabled if the value in the Split/Skill field is not 
Id.

Priority High is the default, or select Low, Medium, or Top from 
the drop-down list. This field is disabled if the value in 
the Split/Skill field is Best.

Comparator Auto-selected default. This is a read-only field.

Threshold One (1) is the default, or enter a numeric value that 
depends on Measure and the software version of your 
switch.

Comment Enter a comment associated with this step.
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Center Info (Queue) step The following table describes the Center Info (Queue) step:

Agent Activity (Queue)
step

The following table describes the Agent Activity (Queue) step:

Properties Description

Measure Expected-wait is the available value.

Split/Skill Select a split/skill (First, Second, Third, Best, or Id) from 
the drop-down list.

Skill Id Enter a numeric value from 1 to 999 (default=1). This 
field is disabled if the value in the Split/Skill field is not 
Id.

Priority Low is the default, or select Medium, High, or Top from 
the drop-down list. This field is disabled if the value in 
the Split/Skill field is Best.

Comparator Auto-selected default. This is a read-only field.

Threshold One (1) is the default, or enter a numeric value that 
depends on Measure and the software version of your 
switch.

Comment Enter a comment associated with this step.

Properties Description

Measure Available-agents is the default, or select staffed-agents 
from the drop-down list.

Split/Skill Select a split/skill (First, Second, Third, or Id) from the 
drop-down list.

Skill Id Enter a numeric value from 1 to 999 (default=0). This 
field is disabled if the value in the Split/Skill field is not 
Id.

Priority Low is the default, or select medium, high, or top from 
the drop-down list.

Comparator Auto-selected default. This is a read-only field.

Threshold Zero (0) is the default, or enter a numeric value that 
depends on the Comparator value and your the software 
version of your switch.

Comment Enter a comment associated with this step.
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Queue Unconditional
(Queue) step

The following table describes the Queue Unconditional (Queue) step:

Route To Number
(Routing) step

The following describes the Route To Number (Routing) step:

Route To Digits
(Routing) step

The following table describes the Route To Digits (Routing) step:

Adjunct Route (Routing)
step

The following table describes the Adjunct Route (Routing) step:

Properties Description

Split/Skill Select a split/skill (First, Second, Third, Id, or Best) from 
the drop-down list.

Skill Id Enter a numeric value from 1 to 999 (default=0). This 
field is disabled if the value in the Split/Skill field is not 
Id.

Priority High is the default, or select low, medium, or top from the 
drop-down list. This field is disabled if the value in the 
Split/Skill field is Best.

Comment Enter a comment associated with this step.

Properties Description

Number Null is the default, or enter a 1 to 16 digit number or other 
valid characters, including *, #, ~p, ~w, ~W, ~m, ~s, and 
~r. ~r can only be at the beginning and has to be followed 
by numbers only.

Coverage No is the default, or select yes from the drop-down list.

Comment Enter a comment associated with this step.

Properties Description

Coverage No is the default, or select yes from the drop-down list.

Comment Enter a comment associated with this step.

Properties Description

Extension Enter an extension number from 1 to 5 digits. Default is 
null.

Comment Enter a comment associated with this step.
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Messaging Skill
(Routing) step

The following table describes the Messaging Skill (Routing) step:

Goto Vector (Routing)
step

The following table describes the Goto Vector (Routing) step:

Properties Description

Split/Skill Select a split/skill (First, Second, Third, or Id) from the 
drop-down list.

Skill Id Enter numeric value from 1 to 999 (default=0). This field 
is disabled if the value in the Split/Skill field is not Id.

Extension Extension is the default, or select Active or Latest.

Number Enter an extension number from 1 to 5 digits. This field is 
disabled if the Extension field is active or latest.

Comment Enter a comment associated with this step.

Properties Description

Vector Select a valid vector from the drop-down list, or select Id.

Vector Id Enter the numeric Id of a valid vector. This field is 
disabled if the value in the Vector field is not Id.

Comment Enter a comment associated with this step.
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.........................................................................................................................................................................................................................................................
Creating a new Goto vector

Introduction The following scenario gives an example of how to create a Goto vector. 
Because this scenario contains so many steps, it has been divided into 
several topics for readability.

Procedure To create a new Goto vector:

........................................................................................................................................................................

1 Start CentreVu Visual Vectors.

Result:  The system displays the CentreVu Framework window.

........................................................................................................................................................................

2 In the CentreVu Framework window, select Tools and then select 9 
Vector (EAS) from the for Vector Editor submenu.

Result:  The system displays the Vector Editor window for a New 
Vector. The first step is an empty (grey) box.

To start your new vector, you want processing to branch to a different 
vector for nighttime callers only. First, you must test for the time of 
day.

........................................................................................................................................................................

3 On the left side of the Vector Editor window, click the Test palette.

Result:  The system displays the available icons on the Test palette.

........................................................................................................................................................................

4 Using the ToolTips (if enabled), click the Time Of Day icon. Use the 
drag-and-drop method to move the icon to the empty step box in the 
workspace area.

Result:  A yellow box appears when you can drop the icon.

........................................................................................................................................................................

5 Double-click the Time Of Day icon.

Result:  The system displays the Properties of Time Of Day window. 
This window contains default values.
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........................................................................................................................................................................

6 Select Start Time: and enter 23:00, and select Finish Time: and enter 
5:00.

Leading zeroes are discarded from numeric entries.

........................................................................................................................................................................

7 Type a comment for this test in the Comment: field, and then click OK.

Result:  The Properties window closes and the label for this test icon 
changes to “TOD All 23:00 to All 05:00.”

Two arrows to empty step boxes now appear in the workspace. The 
solid arrow points to the next step if the test is true. The broken or 
dotted arrow points to the next step if the test is false. 

........................................................................................................................................................................

8 Click the Routing palette.

Result:  The system displays the available icons on the Routing 
palette.

........................................................................................................................................................................

9 Click the Goto Vector icon. Use the drag-and-drop method to move the 
icon to the empty step box for TRUE in the workspace area.

Result:  A yellow box appears when you can drop the icon.

........................................................................................................................................................................

10 Double-click the Goto Vector icon.

Result:  The Properties of the Goto Vector window appears with the 
required field outlined in red.

........................................................................................................................................................................

11 Select Vector ID: and enter 2.

Result:  The OK and Apply buttons are enabled in the Properties 
window.

........................................................................................................................................................................

12 Type a comment for this step in the Comment: field, and then click OK.

Result:  The Properties window closes and the label for this step icon 
changes to Vector 2.

E N D  O F  S T E P S.................................................................................................................................................................................
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Disconnecting weekend
calls

Next, you need to disconnect weekend callers after the system plays an 
announcement. To disconnect weekend calls:

........................................................................................................................................................................

1 To test the weekend condition, click the Test palette again.

Result:  The system displays the available icons on the Test palette.

........................................................................................................................................................................

2 Using the ToolTips (if enabled), click the Time Of Day icon again. Use 
the drag-and-drop method to move the icon to the empty step box for 
FALSE in the workspace area.

Result:  A second conditional branch is created, with two arrows 
pointing to empty step boxes.

........................................................................................................................................................................

3 Double-click the Time Of Day icon.

Result:  The system displays the Properties of Time Of Day window. 
This window contains default values.

........................................................................................................................................................................

4 In the Properties of Time of Day window:

• Select Friday from the Start Day: drop-down list.

• Select Monday from the Finish Day: drop-down list.

• Select Start Time: and enter 20:00.

• Select Finish Time: and enter 5:00.

Leading zeroes are discarded from numeric entries.

........................................................................................................................................................................

5 Type a comment for this test in the Comment: field, and then click OK.

Result:  The Properties window closes, and the label for this test icon 
changes to “TOD Fri 20:00 to Mon 05:00.”

........................................................................................................................................................................

6 You want processing to branch to a different vector for weekend callers 
only. Click the Input/Output palette.

Result:  The system displays the available icons on the Input/Output 
palette.
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........................................................................................................................................................................

7 Using the ToolTips (if enabled), click the Announcement icon. Use the 
drag-and-drop method to move the icon to the empty step box for 
TRUE in the workspace area.

Result:  A yellow box appears when you can drop the icon.

........................................................................................................................................................................

8 Double-click the Announcement icon.

Result:  The system displays the Properties of Announcement 
window. The Extension: field is required.

........................................................................................................................................................................

9 Select Extension: and enter 84573.

Result:  The OK and Apply buttons are enabled in the Properties 
window.

........................................................................................................................................................................

10 Type a comment for this test in the Comment: field, and then click OK.

Result:  The Properties window closes and the label for this icon 
changes to “Ext 84573.”

........................................................................................................................................................................

11 Next, you need to disconnect weekend callers after the system plays an 
announcement. To test the weekend condition, click the End palette.

Result:  The system displays the icons on the End palette.

........................................................................................................................................................................

12 Using the ToolTips (if enabled), click the Disconnect icon. Use the 
drag-and-drop method to move the icon to the empty step box for 
TRUE in the workspace area.

Result:  A yellow box appears when you can drop the icon. The 
Disconnect step icon ends this conditional branch.

Two arrows to empty step boxes now appear in the workspace. The 
solid arrow points to the next step if the test is true. The broken or 
dotted arrow points to the next step if the test is false.
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........................................................................................................................................................................

13 If the weekend condition tests false, you want to queue the call. Click 
the Queue palette.

Result:  The system displays the icons on the Queue palette.

........................................................................................................................................................................

14 Using the ToolTips (if enabled), click the Queue Unconditional icon. 
Use the drag-and-drop method to move the icon to the empty step box 
for FALSE in the workspace area.

Result:  A yellow box appears when you can drop the icon.

........................................................................................................................................................................

15 Double-click the Queue Unconditional icon.

Result:  The system displays the Properties of Queue Unconditional 
window.

........................................................................................................................................................................

16 Select Id from the Skill: drop-down list.

Result:  The Skill Id: field is enabled and required.

........................................................................................................................................................................

17 Select Skill Id: and enter 1.

Result:  The OK and Apply buttons are enabled in the Properties 
window.

........................................................................................................................................................................

18 Type a comment for this test in the Comment: field, and then click OK.

Result:  The Properties window closes and the label for this icon 
changes to Skill 1.

E N D  O F  S T E P S.................................................................................................................................................................................
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Selecting ringback Next, you want callers to wait while the system rings back. To activate 
ringback:

........................................................................................................................................................................

1 On the left side of the Vector Editor window, click Input/Output.

Result:  The system displays the icons in the Input/Output window.

........................................................................................................................................................................

2 Using the ToolTips (if enabled), click the Ringback icon.

........................................................................................................................................................................

3  Use the drag-and-drop method to move the icon to the empty step box 
in the workspace area.

Result:  A yellow box appears when you can drop the icon.

........................................................................................................................................................................

4 Double-click the Ringback icon.

Result:  The system displays the Properties of Ringback window. 
This window contains a default value of 0 seconds.

........................................................................................................................................................................

5 Select the Seconds: field, and change the highlighted default value to 
18.

Result:  The Apply button is enabled in the Properties window.

........................................................................................................................................................................

6 Type a comment for this test in the comment: field, and then click OK.

Result:  The Properties window closes and the label for this step icon 
changes to 18 secs.

Next, you want to collect a digit after playing an announcement for 
the caller. 

........................................................................................................................................................................

7 Using the ToolTips (if enabled), click the Announcement icon. Use the 
drag-and-drop method to move the icon to the empty step box in the 
workspace area.

Result:  A yellow box appears when you can drop the icon.
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........................................................................................................................................................................

8 Double-click the Announcement icon.

Result:  The system displays the Properties of Announcement 
window.

The Extension: field is required.

........................................................................................................................................................................

9 Select the Extension: field and enter 72349. 

Result:  The OK and Apply buttons are enabled in the Properties 
window.

........................................................................................................................................................................

10 Type a comment for this test in the Comment field, and then click OK.

Result:  The Properties window closes and the label for this icon 
changes to “Ext 72349.”

........................................................................................................................................................................

11 Using the ToolTips (if enabled), click the Collect icon.

........................................................................................................................................................................

12 Use the drag-and-drop method to move the icon to the empty step box 
in the workspace area.

Result:  The label shows the default is to collect 1 digit, so you do not 
need to edit the default properties of this icon.

E N D  O F  S T E P S.................................................................................................................................................................................

Routing callers Next, you want to route callers conditionally, based on the collected digit. 
You can add the condition later. To route callers:

........................................................................................................................................................................

1 Click the Routing palette.

Result:  The system displays the icons on the Routing palette.

........................................................................................................................................................................

2 Using the ToolTips (if enabled), click the Route To Number icon.
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........................................................................................................................................................................

3  Use the drag-and-drop method to move the icon to the empty step box 
in the workspace area.

Result:  A yellow box appears when you can drop the icon.

........................................................................................................................................................................

4 Double-click the Route To Number icon.

Result:  The system displays the Properties of Route To Number 
window. This window contains default values.

........................................................................................................................................................................

5 Select the Number: field and change the highlighted default value to 
93031234567.

Result:  The Apply button is enabled in the Properties window.

........................................................................................................................................................................

6 Type a comment for this test in the Comment: field, and then click OK.

Result:  The Properties window closes and the label for this icon 
changes to “93031234567 no.”

........................................................................................................................................................................

7 You must add the conditional branch. Click the Test palette.

Result:  The system displays the available icons on the Test palette.

........................................................................................................................................................................

8 Using the ToolTips (if enabled), click the Caller Info icon. Use the 
drag-and-drop method to move the icon onto the arrow BEFORE the 
Route To Number icon in the workspace area.

Result:  A yellow box appears when you can drop the icon between 
existing icons.

........................................................................................................................................................................

9 Double-click the Caller Info icon.

Result:  The system displays the Properties of Caller Info window. 
This window contains default values.
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........................................................................................................................................................................

10 Select digits from the drop-down list for the Measure: field.

Result:  The Apply button is enabled.

........................................................................................................................................................................

11 Select the Threshold: field and change the default value to 5.

Result:  The highlighted value changes in the Properties window.

........................................................................................................................................................................

12 Type a comment for this test in the Comment: field, and then click OK.

Result:  The Properties window closes and the label for this icon 
changes to DIG = 5.

There are now two empty step boxes in the workspace area. The true 
box (solid arrow) is the next step if the collected digit was 5; 
otherwise, the false box is next. 

........................................................................................................................................................................

13 If the collected digit was not 5, you want callers to wait while the 
system plays music, so click the Input/Output palette. 

Result:  The system displays the available icons on the Input/Output 
palette.

........................................................................................................................................................................

14 Using the ToolTips (if enabled), click the Music icon. Use the drag-
and-drop method to move the icon onto the empty box for FALSE in 
the workspace area.

Result:  A yellow box appears when you can drop the icon.

........................................................................................................................................................................

15 Double-click the Music icon.

Result:  The system displays the Properties of Music window. This 
window contains a default value of 0 seconds.
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........................................................................................................................................................................

16 Select the Seconds: field and change the highlighted default value to 
30.

Result:  The Apply button is enabled in the Properties window.

........................................................................................................................................................................

17 Type a comment for this test in the Comment: field, and then click OK.

Result:  The Properties window closes and the label for this step icon 
changes to “30 secs.”

E N D  O F  S T E P S.................................................................................................................................................................................

Playing an
announcement

You want to play an announcement for callers every 30 seconds. To play 
the announcement:

........................................................................................................................................................................

1 Using the ToolTips (if enabled), click the Announcement icon. Use the 
drag-and-drop method to move the icon onto the empty box after the 
Music icon in the workspace area.

Result:  A yellow box appears when you can drop the icon.

........................................................................................................................................................................

2 Double-click the Announcement icon.

Result:  The system displays the Properties of Announcement 
window. The Extension: field is required.

........................................................................................................................................................................

3 Select the Extension: field and enter 74934.

Result:  The OK and Apply buttons are enabled in the Properties 
window.

........................................................................................................................................................................

4 Type a comment for this test in the Comment: field, and then click OK.

Result:  The Properties window closes and the label for this icon 
changes to “Ext 74934.”



  
Using the Vector Editor CentreVu Visual Vectors User Guide

Creating a new Goto vector 5-48

........................................................................................................................................................................

5 Now, to create a loop back to hearing music, drag the empty step box 
to the FALSE arrow immediately BEFORE the Music step icon.

Result:  A solid line joins this arrow, showing the unconditional 
nature of this Goto step.

There is still an empty step box after the Route To Number icon. 

........................................................................................................................................................................

6 To finish editing your new vector, click the End palette.

Result:  The system displays the available step icons in the End 
palette.

........................................................................................................................................................................

7 Using the ToolTips (if enabled), click the Music icon. Use the drag-
and-drop method to move the icon onto the empty box step box in the 
workspace area.

Result:  A yellow box appears when you can drop the icon. The Stop 
step icon ends this conditional branch.

........................................................................................................................................................................

8 If you have not already saved your work, select Save from the File 
menu or toolbar in the Vector Editor window.

Result:  The first time you save, a window will appear in which you 
specify where to save the vector. This can be offline in a ScratchPad, 
or online to a permitted ACD’s Vector Folder. If your vector is new on 
the ACD, that is, if you are not saving using an existing vector’s name, 
the system asks you for a Name and ID. If you used the name of an 
existing vector while saving, the system asks you if you want to 
overwrite the existing vector.

E N D  O F  S T E P S.................................................................................................................................................................................
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.........................................................................................................................................................................................................................................................
Moving or copying vectors to ACDs of different types

Inroduction You can move or copy vectors from one ACD to another using Navigator. 
You can also open or create a vector of one type and save it to an ACD of 
a different type, or copy and paste one or more steps between different 
vectors using the Vector Editor tool. In these situations, vector steps need 
conversion. The software guides you through the conversion process.

Procedure To move or copy vectors to ACDs of different types:

........................................................................................................................................................................

1 Open an existing vector or create a new R9 Vector (EAS). This vector 
must contain skill-related properties of steps such as Queue Activity, 
Center Info, or Agent Activity, and digit properties of steps such as 
Converse or Collect.

........................................................................................................................................................................

2 Copy the whole vector or set of steps described in Step 1. Do one of the 
following:

• To select all steps in the vector, in the Edit menu click Select All. 
Then select Copy in the Edit menu to copy the steps.

• To select a set of steps in the vector, hold down the Shift key while 
you click on each step you want to copy. Then select Copy in the 
Edit menu to copy the steps.

........................................................................................................................................................................

3 Open an existing vector, or create a new Vector (non-EAS, non-
Prompting).



  
Using the Vector Editor CentreVu Visual Vectors User Guide

Moving or copying vectors to ACDs of different types 5-50

........................................................................................................................................................................

4 In the vector you opened or created in Step 4, select Paste in the Edit 
menu to paste the whole vector or set of steps you previously copied. 

Result:  The system displays one or more messages explaining the 
necessary conversions.

........................................................................................................................................................................

5 Perform one of the following actions:

• Select Yes to correct incompatible steps individually.

• Select Yes to All to correct all steps of the same type in all of the 
vectors or steps that are currently selected.

E N D  O F  S T E P S.................................................................................................................................................................................
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6 Using the VDN Assignment 
Wizard

.........................................................................................................................................................................................................................................................
Overview

Purpose This chapter explains how to use the VDN Assignment Wizard. It includes 
the following sections:

• Introduction to the VDN Assignment Wizard

• Using VDN Assignment windows

See the overview of each section for a preview of the section's contents.
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Introduction to the VDN Assignment 
Wizard

.........................................................................................................................................................................................................................................................
Overview 

Purpose This section provides an overview of the Visual Vectors VDN 
Assignment Wizard.

In this section This section includes the following information:

• Features of the VDN Assignment Wizard

• Opening and closing the VDN Assignment Wizard

• VDN Assignment Wizard window objects
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.........................................................................................................................................................................................................................................................
Features of the VDN Assignment Wizard

Introduction When your DEFINITY switch receives a call, it translates objects dialed 
by the caller or sent to it into a VDN. The DEFINITY switch uses VDNs 
to direct those calls to the appropriate vector. When your vectors are 
complete and ready to use, the VDN Assignment Wizard helps you assign 
VDNs to your vectors so that incoming calls associated with those VDNs 
get treated the way your organization wants them to be treated.
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.........................................................................................................................................................................................................................................................
Opening and closing the VDN Assignment Wizard

Introduction This section explains how to open and close the VDN Assignment 
Wizard.

Opening the VDN
Assignment wizard

To open the VDN Assignment Wizard:

........................................................................................................................................................................

1 Select Start from the Microsoft Windows taskbar.

........................................................................................................................................................................

2 Select Programs from the Start menu.

........................................................................................................................................................................

3 Select the Avaya CentreVu Visual Vectors V9 program group.

........................................................................................................................................................................

4 Select CentreVu Visual Vectors V9.

Result:  The system starts the Visual Vectors program and opens the 
Framework window. Although Visual Vectors is running, you are not 
yet connected to a CMS server.

The following figure illustrates how the main window appears before 
you log in to a CMS server.

........................................................................................................................................................................

5 You must connect to a CMS server to assign VDNs to a vector. See 
Starting and exiting CentreVu Framework for more information.
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........................................................................................................................................................................

6 To open the VDN Assignment Wizard window, select VDN 
Assignment Wizard from the Framework Tools menu, or click the 
VDN Assignment Wizard icon in the Framework toolbar.

The system displays the VDN Assignment Wizard window.

E N D  O F  S T E P S.................................................................................................................................................................................

Closing the VDN
Assigment Wizard

To close one VDN Assignment window, do one of the following:

• Click Cancel in the VDN Assignment Wizard window.

• Press Alt+F4 while the window that you want to close is active.

• Select Close from the CentreVu Framework Window menu and then 
select the window you want to close from the drop-down menu.

To close all VDN Assignment windows, select Close All from the 
CentreVu Framework Window menu.

If you have unsaved changes to the current vector, the system asks you if 
you want to save them.

For information on exiting the VDN Assignment Wizard, see Closing 
windows and exiting (3-7).
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.........................................................................................................................................................................................................................................................
VDN Assignment Wizard window objects

Introduction This part introduces you to the features of the VDN Assignment window.

VDN Assignment Wizard
window

The following figure shows the VDN Assignment Wizard window:

Title bar The title bar shows the name of the application. 

Minimize, maximize/
restore and close

buttons

These buttons in the upper right corner of the window adjust the size of 
the current window, or close it.
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Buttons These five buttons appear on the VDN Assignment Wizard windows:

Button Function

Cancel Closes the wizard without making or changing any 
assignments.

Back Displays the previous window in the wizard. This button is 
disabled on the first window.

Next Accesses the next window in the wizard. This button is 
replaced by the Edit button in the last window. See Edit.

Edit Accesses the properties window for one or more selected 
VDNs. This is the last window of the VDN Assignment 
Wizard.

Help Accesses help information about the current window. 



  
Using the VDN Assignment Wizard CentreVu Visual Vectors User Guide

Using VDN Assignment windows 6-8

Using VDN Assignment windows

.........................................................................................................................................................................................................................................................
Overview 

Purpose This section explains how to use the features of the VDN Assignment 
window. Follow the instructions to make VDN selections, use windows, 
and enter values in input fields.

In this section This section includes the following information:

• Assigning VDNs



  
Using the VDN Assignment Wizard CentreVu Visual Vectors User Guide

Assigning VDNs 6-9

.........................................................................................................................................................................................................................................................
Assigning VDNs

Introduction The VDN Assignment Wizard guides you through the process of 
assigning a VDN and skill preference to a vector. It consists of several 
dialog boxes in sequence, for example, one dialog box filters and selects 
the VDNs you wish to assign, and another dialog box performs the 
assignments.

Accessing the VDN
Assignment Wizard

Follow these steps to use the first window of the VDN Assignment 
Wizard.

........................................................................................................................................................................

1 In the CentreVu Framework window, do one of the following:

• Select VDN Assignment Wizard from the Tools menu.

• Click the VDN Assignment Wizard icon in the toolbar.

The system displays the VDN Assignment Wizard Welcome 
window.
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........................................................................................................................................................................

2 Browse your Call Center World to find the object you want. See 
Exploring objects (4-15).

Important! If you are not connected to a server, you need to 
double-click the server and complete the “Connect to (server name)” 
window before you can view its ACDs.

........................................................................................................................................................................

3 Click the ACD that contains the object you want to assign.

In the following figure, the ACD “PelicanR8e” has been selected.
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........................................................................................................................................................................

4 Click Next.

The system displays the Available for Selection window.

E N D  O F  S T E P S.................................................................................................................................................................................
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Using the Available for
Selection window

In the Available for Selection window, you may display a list of all VDNs 
available for selection, or you may filter the list to display only those 
VDNs containing certain criteria.

........................................................................................................................................................................

1  To filter the list of VDNs Available for Selection, enter any of the 
following parameters in the Filter: text box.

 These parameters can be from 1 to 20 characters. These characters can 
include:

• Letters

• Numbers

• Underscores �B�

• Blanks

• Commas ���

• Periods ���

• Plus signs ���

These characters cannot include:

• Backslash �?�

• Grave accent �C�

• Tilde �a�

• Double quotes ���

• Pipe symbol �_�

These parameters can include pattern-matching wildcards, such as:

• Question mark �"� (exactly one character)

• Asterisk �
� (any number of characters, including none)

Entering characters or characters with wildcards restricts the VDNs that 
are displayed in the Available for Selection (Filtered): list box to those 
that partially or completely match your entry. For example

• Entering 
6DOHV
 matches and displays available VDNs named 
3UH�6DOHV, 6DOHV, and 6DOHV�6SOLW.

• Entering 9'1
� matches and displays available VDNs named 9'1�, 
9'1����, and 9'16XSSRUW��.
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The following example shows the VDNs that have been filtered to include 
only those VDNs with names containing the characters 

Y���

 and higher.

........................................................................................................................................................................

2 Take one of the following actions to select one or more VDNs you want 
to administer from the filtered list of VDNs that are available for 
selection: 

• Select the VDN in the Available for Selection: list box and then click 
the down arrowhead ↓ button.

• Hold down the Control key while you select each one of the VDNs 
that you want and then click the down arrowhead ↓ button.

• Hold down the Shift key while you select the first and last in a group 
of VDNs that you want and then click the down arrowhead ↓ button.
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• Click the down arrowhead button with the horizontal line under it to 
move all VDNs that are in the filtered Available for Selection: list 
box to the Selected: list box.

You may deselect one or more VDNs by reversing any of these actions, 
for example clicking the up arrowhead button ↑ to move highlighted 
VDNs in the Selected: list box back to the Available for Selection: list 
box.

The following figure shows the Selected list of VDNs below the filtered 
list of VDNs Available for Selection.
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........................................................................................................................................................................

3  Click Next to go to the next window in the wizard.

Result:  The system displays the Edit Assignment window.

E N D  O F  S T E P S.................................................................................................................................................................................
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Using the Edit
Assignment window

To use the Edit Assignment window:

........................................................................................................................................................................

1 First, check the Selected ACD and Selected VDNs shown to confirm 
that the are the ones you want to assign or edit.

Example:  The following figure shows the Selected VDNs from 
30019 through 30022.

........................................................................................................................................................................

2 Click Edit to assign the selected VDNs to a vector or to change other 
VDN object properties. If you select:

• One VDN, the property window for that VDN shows the values in its 
property fields that you can edit.

• Many VDNs with different values, the property window shows blank 
property fields for you to complete.



  
Using the VDN Assignment Wizard CentreVu Visual Vectors User Guide

Assigning VDNs 6-17

• Many VDNs with the same values, the property window shows the 
common values in the property fields.

Example:  This Properties of many objects window shows the 
common values in the property fields.

If the Selected VDN is already assigned to a common vector, the Id of 
that vector is the default, for example, ATP Vector E. If the selected 
VDN is not already assigned to a vector, then “1” is the default.
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........................................................................................................................................................................

3  Perform one of the following actions:

• If you do not want to change the default vector Id, go to Step 5.

• If you want to change the vector Id, click the down arrow in the 
Vector Id field.

The system displays the Vector Id: drop-down list.

........................................................................................................................................................................

4 Select the vector Id you want from the drop-down list.
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........................................................................................................................................................................

5  If the EAS feature has been purchased and enabled on the selected 
ACD, you need to select one or more skill preferences. If the Selected 
VDNs are already assigned common skills, those skills are the default 
selections.

In the Properties of many objects window shown below, the Selected 
VDNs are already assigned common skills.

........................................................................................................................................................................

6 Click the down arrow in the Skil Pref: field you want to change. If you 
choose [none] for: 

• Skill Preference 1, then Skill Preference 2 and Skill Preference 3 also 
must be [none].

• Skill Preference 2, then Skill Preference 3 also must be [none].

Note that choosing [none] removes existing skill preferences from those 
selected VDNs that have them.



  
Using the VDN Assignment Wizard CentreVu Visual Vectors User Guide

Assigning VDNs 6-20

........................................................................................................................................................................

7 Perform one of the following actions:

• Click OK to commit all the VDN Assignments and any other 
changes to VDN properties and close the window. 

• Click Apply to commit changes but leave the VDN Properties 
window open for further input.

E N D  O F  S T E P S.................................................................................................................................................................................
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7 Using the Import Export Wizard

.........................................................................................................................................................................................................................................................
Overview

Purpose This chapter explains how to use the Visual Vectors Import Export Wizard. It 
includes the following sections:

• Introduction to the Import Export Wizard

• Importing and exporting vectors

See the overview of each section for a preview of the section's contents.
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Introduction to the Import Export 
Wizard

.........................................................................................................................................................................................................................................................
Overview 

Purpose This section provides information about the Import Export Wizard and 
explains how to start and exit the Import Export tool.

In this section This section includes the following information:

• Features of the Import Export Wizard

• Opening and closing the Import Export Wizard

• Import Export Wizard objects
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.........................................................................................................................................................................................................................................................
Features of the Import Export Wizard

Introduction The Visual Vectors Import Export feature lets you create a vector and 
export it to a public directory or other application, where the vector can be 
imported and shared by other users.

For example, first you create a vector file, which can contain one or more 
vector objects. You can then attach the vector file to email or export it to a 
shared or public directory. Other users can then import this vector file to 
their system where, using Visual Vectors tools, they can view and edit it 
or load it to a DEFINITY server.

The Import Export Wizard provides a means for you to:

• Distribute vectors within a single site or across a multi-site 
environment 

• Share vectors with users from other organizations 

• Create a central library of vectors that other users can access

• Archive vectors to a server on a LAN for backup 

• Train and mentor other users (review vectors and mail back 
corrections and suggestions)

Important! Vectors cannot be imported to other applications, for 
example, Microsoft Project or Visio.
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.........................................................................................................................................................................................................................................................
Opening and closing the Import Export Wizard

Introduction This section explains how to open and close the Import Export Wizard.

Opening the Import
Export Wizard

To open the Import Export Wizard:

........................................................................................................................................................................

1 Select Start from the Microsoft Windows toolbar.

........................................................................................................................................................................

2 Select Programs from the Start menu.

........................................................................................................................................................................

3 Select the Avaya CentreVu Visual Vectors V9 program group.

........................................................................................................................................................................

4 Select CentreVu Visual Vectors V9.

Result:  The system starts the Visual Vectors program and opens the 
Framework window. Although Visual Vectors is running, you are not 
yet connected to a CMS server.

The following figure illustrates how the main window appears before 
you log in to a CMS server.

You do not have to connect to a CMS server at this point, but you will 
need to connect to a CMS server before you can import or export 
vectors. See Starting and exiting CentreVu Framework for more 
information.
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........................................................................................................................................................................

5 To start the Import Export Wizard, select Import Export Wizard from 
the Framework Tools menu, or click the Import Export Wizard icon in 
the Framework toolbar.

Result:  The system displays the Import Export Wizard.

E N D  O F  S T E P S.................................................................................................................................................................................

Closing the Import
Export Wizard

To close one wizard window, do one of the following:

• Click Cancel in the Import Export Wizard window, or press Escape 
on your keyboard.

• Press Alt+F4 while the window that you want to close is active.

• Select Close from the CentreVu Framework Window menu, and then 
select the window you want to close from the drop-down menu.

To close all windows, select Close All from the CentreVu Framework 
window menu.

If you have unsaved changes to the current vector, the system asks you if 
you want to save them.

For information on exiting the VDN Assignment Wizard, see Closing 
windows and exiting (3-7).
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.........................................................................................................................................................................................................................................................
Import Export Wizard objects

Introduction This part introduces you to the features of the Import Export Wizard 
window.

Import Export Wizard
window

‘The following figure shows the Import Export Wizard window:

Title bar The title bar shows the name of the application.

Minimize, maximize/
restore and close

buttons

These buttons in the upper right-hand corner adjust the size of the current 
window, or close it. 
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Buttons These four buttons appear on the windows of the Import Export Wizard:

Button Function

Cancel Closes the wizard without making or changing any 
assignments.

Back Displays the previous window in the wizard. This button is 
disabled on the first window.

Next Accesses the next window in the wizard. This button is 
replaced by the Export button in the last window. See 
Export.

Export Initiates the export process.

Help Accesses help information about the current window. 
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Importing and exporting vectors

.........................................................................................................................................................................................................................................................
Overview 

Purpose This section explains how to import and export vectors.

In this section This section includes the following information:

• Exporting Vectors

• Importing vectors
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.........................................................................................................................................................................................................................................................
Exporting Vectors

Introduction The Import Export Wizard guides you through the process of collecting 
information to export, selecting the vectors to export, and performing the 
export. It consists of several dialog boxes in sequence, for example, one 
dialog box filters and selects the vectors you wish to export, and another 
dialog box performs the export.

Accessing the Import
Export Wizard

Follow these steps to use the first window of the Import Export Wizard.

........................................................................................................................................................................

1 In the CentreVu Framework window, do one of the following:

• Select Import Export Wizard from the Tools menu.

• Click the Import Export Wizard icon in the toolbar.

The system displays the Vector Import Export Wizard Welcome window.



  
Using the Import Export Wizard CentreVu Visual Vectors User Guide

Exporting Vectors 7-10

........................................................................................................................................................................

2 Select Export, and then click Next.

The system displays the second window of the Import Export Wizard.

........................................................................................................................................................................

3 Browse your Call Center World and find the ACD or ScratchPad folder 
containing the vectors you want to export. See Exploring 
objects (4-15).

Important! If you are not connected to a server, you need to 
double-click the server and complete the “Connect to (server name)” 
window before you can view its ACDs.
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........................................................................................................................................................................

4 Click the ScratchPad folder or ACD that contains the vectors you want 
to export.

Example:  In the following example, the Default ScratchPad has been 
selected.

........................................................................................................................................................................

5 Click Next. 

Result:  The system displays the Available for Selection window.

E N D  O F  S T E P S.................................................................................................................................................................................
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Using the Available for
Selection window

In the Available for Selection window, you may display a list of all 
vectors available for export, or you may filter the list to display only those 
vectors containing certain criteria.

........................................................................................................................................................................

1  To filter the list of vectors available for selection, enter any of the 
following parameters in the Filter: text box.

 These parameters can be from 1 to 20 characters. These characters can 
include:

• Letters

• Numbers

• Underscores �B�

• Blanks

• Commas ���

• Periods ���

• Plus signs ���

These characters cannot include:

• Backslash �?�

• Grave accent �C�

• Tilde �a�

• Double quotes ���

• Pipe symbol �_�

These parameters can include pattern-matching wildcards, such as:

• Question mark �"� (exactly one character)

• Asterisk �
� (any number of characters, including none)

Entering characters or characters with wildcards restricts the VDNs that 
are displayed in the Available for Selection (Filtered): list box to those 
that partially or completely match your entry. For example

• Entering 
6DOHV
 matches and displays available vectors named 
3UH�6DOHV, 6DOHV, and 6DOHV�6SOLW.

• Entering 4)$
� matches and displays available vectors named 4)$�, 
4)$����, and 4)$6XSSRUW��.
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Example:  The following example shows the vectors that have been 
filtered to include only those vectors with names containing the 
characters 

4)$

........................................................................................................................................................................

2 Take one of the following actions to select one or more vectors you 
want to export from the filtered list of vectors that are available for 
selection: 

• Select the vector in the Available for Selection: list box, and then 
click the down arrowhead ↓ button.

• Hold down Control while you select each one of the vectors that you 
want and then click the down arrowhead ↓ button.

• Hold down Shift while you select the first and last in a group of 
vectors that you want and then click the down arrowhead ↓ button.

• Click the down arrowhead button with the horizontal line under it to 
move all vectors that are in the filtered Available for Selection: list 
box to the Selected: list box.
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You may deselect one or more vectors by reversing any of these actions; 
for example, using the up arrowhead button ↑ to move highlighted filters 
in the Selected: list box back to the Available for Selection: list box.

Result:  The following figure shows the selected list of vectors below 
the filtered list of vectors available for selection.
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........................................................................................................................................................................

3 Click Next to go to the next window in the wizard.

Result:   The system displays the Export Archive File window.

E N D  O F  S T E P S.................................................................................................................................................................................
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Using the Archive File
and Export Summary

windows

The Export Archive File window lets you choose the archive file to which 
you want to export the vectors.

........................................................................................................................................................................

1 To use the Export Archive File window, do one of the following:

• Enter the full path of the archive file where you want to export the 
vectors.

• Click Browse if you want to browse the network to find the target 
folder where you want to export the vector files.

Result:  The system displays the Select Export Archive dialog box.

........................................................................................................................................................................

2 Explore the network to find the archive file to which you want to export 
the vectors.
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........................................................................................................................................................................

3 When you find the file, highlight it and click Open.

Result:  The system displays the Export Archive File window, which 
shows the path of the file you selected.

........................................................................................................................................................................

4 Click Next. The window that appears depends on whether or not the 
archive file you are exporting is already present in the destination 
folder. For example:

• If the archive file is already present, the system displays a window 
that gives you the opportunity to specify how you want to handle the 
files. Go to Step 5.

• If the archive file is not present, the Vector Export Summary window 
appears. Go to Step 6.
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........................................................................................................................................................................

5 If the archive file is already present, the system displays the window 
shown below. Perform one of the following actions:

• If you do not want to export those vectors whose names already exist 
in the destination file, click “Do not overwrite duplicates.”

• If you do not want to overwrite those vectors whose names already 
exist in the destination file, click “Overwrite duplicates.”

• If you want to create a new file to replace the old one, click “Replace 
the entire contents of the file.”

Example:   In the example below, “Overwrite Duplicates” has been 
selected.
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........................................................................................................................................................................

6 Click Next. 

Result:   The system displays the Vector Export Summary window. 
This window summarizes the information collected to perform the 
export action.
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........................................................................................................................................................................

7 Perform one of the following actions:

• If you need to modify the values on this window, click Back to go to 
previous windows. 

• If you are satisfied with your choices, click Export to initiate the 
export process.

Result:  When the export is completed, the system displays the 
Export Completed message, which gives the number of vectors 
exported to the archive file.

E N D  O F  S T E P S.................................................................................................................................................................................
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.........................................................................................................................................................................................................................................................
Importing vectors

Introduction The Import Export Wizard guides you through the process of collecting 
information for importing vectors and initiating the import process. It 
consists of several dialog boxes in sequence, for example, one dialog box 
filters and selects the vectors you wish to import, and another dialog box 
performs the import. 

Accessing the Import
Export Wizard

Follow these steps to use the first window of the Import Export Wizard.

........................................................................................................................................................................

1 In the CentreVu Framework window, do one of the following:

• Select Import Export Wizard from the Tools menu.

• Click the Import Export Wizard icon in the toolbar.

Result:  The system displays the Vector Import Export Wizard 
Welcome window.
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........................................................................................................................................................................

2  Select Import, and then click Next.

Result:  The system displays the Import Archive File window.
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........................................................................................................................................................................

3 To use the Import Archive File window, do one of the following:

• Enter the full path of the archive file containing the vectors you want 
to import.

• Click Browse if you want to browse the network to find the archive 
file containing the vectors you want to import.

Result:  The system displays the Browse dialog box.

........................................................................................................................................................................

4 Explore the network to find the file containing the vectors you want to 
import
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........................................................................................................................................................................

5  When you find the file, highlight it and click Open.

Result:  The system displays the Import Archive File window, which 
shows the path of the file you selected.

........................................................................................................................................................................

6 Click Next.

Result:  The system displays the Import Selection window.

E N D  O F  S T E P S.................................................................................................................................................................................
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Using the Available for
Selection and Summary

windows

In the Available for Selection window, you may display a list of all 
vectors available for import, or you may filter the list to display only those 
vectors containing certain criteria.

........................................................................................................................................................................

1  To filter the list of vectors available for selection, enter any of the 
following parameters in the Filter: text box.

 These parameters can be from 1 to 20 characters. These characters can 
include:

• Letters

• Numbers

• Underscores �B�

• Blanks

• Commas ���

• Periods ���

• Plus signs ���

These characters can not include:

• Backslash �?�

• Grave accent �C�

• Tilde �a�

• Double quotes ���

• Pipe symbol �_�

These parameters can include pattern-matching wildcards, such as:

• Question mark �"� (exactly one character)

• Asterisk �
� (any number of characters, including none)

Entering characters or characters with wildcards restricts the VDNs that 
are displayed in the Available for Selection (Filtered): list box to those 
that partially or completely match your entry. For example

• Entering 
6DOHV
 matches and displays available vectors named 
3UH�6DOHV, 6DOHV, and 6DOHV�6SOLW.

• Entering 4)$
� matches and displays available vectors named 4)$�, 
4)$����, and 4)$6XSSRUW��.
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Example:  In the example below, the filter QFA has been entered in 
the Filter: field.

........................................................................................................................................................................

2 Take one of the following actions to select one or more vectors you 
want to import from the filtered list of vectors that are available for 
selection: 

• Highlight the vector in the Available for Selection: list box, and then 
click the down arrowhead ↓ button.

• Hold down Control while you highlight each one of the vectors that 
you want and then click the down arrowhead ↓ button.

• Hold down Shift while you highlight the first and last in a group of 
vectors that you want and then select the down arrowhead ↓ button.

• Click the down arrowhead button with the horizontal line under it to 
move all vectors that are in the filtered Available for Selection: list 
box to the Selected: list box.
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You may deselect one or more vectors by reversing any of these actions; 
for example, using the up arrowhead button ↑ to move highlighted filters 
in the Selected: list box back to the Available for Selection: list box.

Result:  The following figure shows the selected list of vectors below 
the filtered list of vectors available for selection.
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........................................................................................................................................................................

3 Click Next.

Result:  The system displays the next window, which allows you to 
select the ACD or ScratchPad folder to which you want to import the 
vectors.

........................................................................................................................................................................

4 Browse your Call Center World and find the ACD or ScratchPad folder 
to which you want to export the vectors. See Exploring objects (4-15).

Important! If you are not connected to a server, you need to 
double-click the server and complete the “Connect to (server name)” 
window before you can view its ACDs.
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........................................................................................................................................................................

5 Highlight the appropriate ScratchPad folder or ACD.

Example:  In the following example, the Default ScratchPad folder 
has been selected.

........................................................................................................................................................................

6 Perform one of the following:

• If you do not want to import those vectors whose names already exist 
in the destination file, click “Do not overwrite duplicates.”

• If you do not want to overwrite those vectors whose names already 
exist in the destination file, click “Overwrite duplicates.”
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........................................................................................................................................................................

7 Click Next.

Result:   The system displays the Vector Import Summary window. 
This window summarizes the information collected to perform the 
import action.
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........................................................................................................................................................................

8 Perform one of the following:

• If you need to modify the values on this window, click Back to go to 
previous windows. 

• If you are satisfied with your choices, click Import to initiate the 
import process.

Result:  When the import is completed, the system displays the 
Imported Completed message, which gives the number of vectors 
imported to the ACD or ScratchPad.

E N D  O F  S T E P S.................................................................................................................................................................................
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Glossary
Access permissions 

Permissions that are assigned to a user so that the user can gain access to different 
areas of a server or administer specific entities of an ACD, for example, splits or 
skills, trunk groups, vectors, and VDNs.  Access permissions are specified as read 
or write permission. Read permission means that the user can access and view 
data. Write permission means that the user can add, modify, or delete data and 
execute processes.

ACD 
See Automatic Call Distribution.

Active VDN calls 
Also known as counted-calls to VDN. A Call Vectoring capability available with 
G3V4 or later switches. Counted-calls to VDN is a parameter of the “go to step” 
and “go to vector” commands. It provides conditional branching to a different 
step in the same vector or to a different vector based on the number of incoming 
trunk calls a VDN is currently processing in a vector or at an agent.

Agent 
A person that answers calls to an ACD split/skill. The agent  is known to CMS by 
a login identification that is entered on the telephone keypad.

Agent login ID
A number that is entered by an ACD agent from a voice terminal to activate the 
agent position. Agent logins are required for all CMS-measured ACD agents.

Agent skill 
An attribute that is associated with an ACD agent. Agent Skills can be thought of 
as the ability for an agent with a particular set of skills to  handle a call that 
requires one of a set of skills. The meaning of each Agent Skill is defined by the 
customer. Examples of skills are the ability to speak a particular language or the 
expertise to handle a certain product.

See also Primary skill, Secondary skill, and Skill level.

Announcement 
A recorded voice message that normally tells the caller what destination  the call 
has reached. The announcement also often tries to persuade the  caller to stay on 
the line. With Call Vectoring, announcements can be part  of a vector's call 
processing. An announcement is assigned to a vector by  entering an 
announcement number.



  
Glossary CentreVu Visual Vectors User Guide

GL-2

Automatic Call  Distribution (ACD) 
A switch feature using software that channels high-volume incoming and  
outgoing call traffic to agent groups that are known as splits or skills. Also an 
agent state where the extension is engaged on an ACD call.

See also Redirect On No Answer and Auto-Available Split.

Call Center World
A collection of objects and entities that can be viewed and administered through 
CentreVu Framework. What you can access, edit, or assign depends on your 
permissions.

Call Management System  (CMS) 
A software product used by business customers that have Avaya 
telecommunications switches/ECS and receive a large  volume of telephone calls 
that are processed through the Automatic Call  Distribution (ACD) feature of the 
switch/ECS. The CMS collects call-traffic  data, formats management reports, 
and provides an administrative  interface to the ACD feature in the switch.

Call prompting 
A switch feature that routes incoming calls based on information entered  by the 
calling party, such as an account number. The caller receives an  announcement 
and is prompted to select an option from those that are listed in the announcement.

Call Vectoring
A switch feature that provides a highly flexible method for processing ACD calls 
using VDNs and vectors as processing points between trunk groups and splits. 
Call vectoring permits treatment of calls that is independent of splits. Similar to a 
computer program, a call vector is a set of instructions that control the routing of 
incoming calls based on conditions that occur in a call center environment. 
Examples of call vector conditions include time of day and the number of calls in 
queue.

CentreVu Advocate
A set of features designed to enhance call and agent selection within a call center. 
CentreVu Advocate requires CentreVu Supervisor Version 6, DEFINITY ECS 
R6, and Expert Agent Selection. See the CentreVu Advocate User Guide, 585–
215–855, for more information.

CentreVu CMS
See Call Management System.
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CentreVu Framework 
The Visual Vectors software window from which you access tools such as 
Navigator, Vector Editor, and VDN Assignment. You can also use the File menu 
in this window to Connect to or Disconnect from CentreVu CMS servers.

CentreVu Supervisor 
The Call Management System client application for the Microsoft Windows 
operating environment.

CentreVu Visual Vectors window 
The window in which you are currently working, which is usually indicated by a 
highlighted title bar. Visual Vectors has a Framework window and windows for 
each of the tools, including Navigator, Vector Editor, VDN Assignment Wizard, 
and Import Export Wizard.

Container 
An object in your Call Center World that logically contains other entities or 
objects. For example, each CMS object in your Call Center World can contain as 
many as 8 ACD objects, each of which contains entity folders (for 
announcements, split/skill objects, trunk groups, VDNs, and vectors).

Context menu 
See Shortcut menu.

Current window 
The window in which you are currently working, which is usually indicated by a 
highlighted title bar. Visual Vectors has a Framework window and windows for 
each of the tools, including Navigator, Vector Editor, VDN Assignment Wizard, 
and Import Export Wizard.

Data collection off
A state in which CMS is not collecting ACD data. If you turn off data collection, 
CMS does not void data on current call activity.

Data collection on 
A state in which CMS is collecting ACD data.

Database 
A group of files that store ACD data according to a specific time frame:  current 
and previous intrahour real-time data and intrahour, daily, weekly,  and monthly 
historical data.
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Database item 
A name for a specific type of data that is stored in one of the CMS databases. A  
database item may store ACD identifiers such as split numbers or names, login  
IDs, VDNs and so forth. It may also store statistical data on ACD performance 
such as number of ACD  calls, wait time for calls in queue, and current states of 
individual agents.

Database tables 
CMS uses these tables to collect, store, and retrieve ACD data. Standard  CMS 
items (database items) are names of columns in the CMS database  tables.

Date format
The standard format for entering dates on Supervisor reports.

Acceptable formats are:

• Month/day/year (for example, 3/21/93).

• A “-” offset based on today's date (for example, -1 for yesterday). You can also enter a 
range of numbers (for example, 0 through -7).

• Individual data entry items that are separated by a semicolon, for example, 3/21/93;3/23/
93;3/25/93.

• Ranges that are separated by a hyphen, for example, 3/21/93-3/25/93.

When you specify a date for a weekly report, that date or range of dates must 
correspond to the week start day selected in the System Setup-Storage Intervals 
window. If the date and day do not match, the system displays the message “No 
records found” in the status line.

The month start date must be the first day of the month.

Delete 
An action that removes the entry on the window from the database.

Dictionary
A CMS subsystem that can be used to assign names to various call center 
elements such as login IDs, splits or skills, trunk groups, VDNs, and vectors. 
These names appear on reports, making them easier to interpret.

EAS 
See Expert Agent Selection.
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Entity 
A generic term that refers to one of the following: Announcement, Split/Skill, 
Trunk Group, VDN, or Vector. Entities that CentreVu Visual Vectors can view or 
administer include Vectors and VDNs. Entity names are obtained from the 
CentreVu CMS Dictionary; renaming entities using Visual Vectors results in 
changes to the CMS Dictionary.

Error message 
A response from a program that indicates that a problem has arisen or  something 
unexpected has happened that requires your attention.

Expert Agent Selection (EAS)
Expert Agent Selection (EAS) is an optional switch feature that builds on the 
power of the Call Vectoring and ACD features of the switch to match the skills 
required to handle a particular call to an agent who has at least one of the skills 
that a caller requires. The ACD queuing and the Queue and Check Vector 
commands are used to route a call to an agent with the appropriate skill to handle 
that call. With EAS, call distribution is based on skill.

CentreVu CMS collects data on skills in the same manner as it collects data on 
splits.

CentreVu CMS also reports VDN data by VDN skill preference, so that customers 
can assess the call center performance relative to calls requiring particular skills. 
CMS reports how many calls were handled, how long these calls waited for 
service, and the average talk time for calls queued to a particular skill preference 
in a particular VDN.

Folder 
An object in the Navigator tool that contains entities (splits or skills, trunk groups, 
VDNs, and vectors). Folders are used to visually group all entities of a specific 
type for an ACD.

Historical database
Contains intrahour records for up to 62 days, daily records for up to 5 years, and 
weekly and monthly records for up to 10 years for each CMS-measured agent, 
split/skill, trunk, trunk group, vector, and VDN.

Import Export Wizard
The Import Export Wizard, accessed from CentreVu Framework, lets you export 
and import vector files, which makes the vector files accessible to multiple 
locations of a business. The vector files can be exported to a shared or public 
directory, placed in a central library of vectors, or archived to a LAN server, 
where other users may retrieve them by using the import process.
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INFORMIX
A relational database management system that is used to organize CMS historical 
data.

INFORMIX SQL
The interactive interface that is typically used to view the INFORMIX database.

Integrated Services Digital Network (ISDN)
A digital standard for telephony that enables, among other things, telephone, 
television, and computer signals on the same lines.

ISDN 
See  Integrated Services Digital Network.

LAN 
See Local Area Network.

Local Area Network
A private interactive communication network that allows computers to  
communicate over short distances, usually less than 1 mile, at high  data transfer 
rates from 1 Mbps to as high as 100 Mbps.

Logical agent
An EAS feature that associates the agent’s login ID with the physical extension 
when the agent logs in. Properties such as the assigned skills, class of restriction, 
and coverage path are associated with the login ID rather than the physical 
extension. This allows agents to log in at any available set.

Agents are assigned a single set of work mode buttons, rather than one set per 
skill. This simplifies the agent’s interface to the work mode buttons. When the 
“MI” or “AI” button is lit, the agent is available to take a call in any assigned 
skills.

The Logical Agent capability allows calling agents to connect by dialing into their 
login IDs. Calls to login IDs can be treated as direct agent ACD calls, given the 
proper class of restriction, or they can be treated as extension (personal) calls. 
Treating the calls as direct agent calls can be used to help distinguish business-
related calls from personal calls.



  
Glossary CentreVu Visual Vectors User Guide

GL-7

Look Ahead Interflow  (LAI) 
A switch feature that can be used to balance the call load among multiple call 
centers. LAI works with Call Vectoring and ISDN PRI trunks to intelligently 
route calls between call centers. This allows multiple call centers to share work 
loads, expands hours of coverage, and allows calls to be transparently handled by 
call centers in different time zones.

Measured
A term that means an ACD entity (agent, split/skill, trunk, trunk group, vector, 
VDN) has been identified to CMS for collection of data. If the ACD element is 
not measured, no data is collected.

Menu bar 
A menu bar is under the title bar of most windows. The menu bar shows the menu 
names available for that particular window, for example, File and Help. You select 
an item from one of these drop-down menus.

Message windows
Temporary windows that are used only for displaying information like syntactical 
field errors.

Multiuser Mode
a mode in which any administered CMS user can log in to CMS. Data continues 
to be collected if data collection is “on.”

Name (Synonym) Fields
Fields in which you can enter a name (synonym) that has been entered in the CMS 
Dictionary, for example, names of splits or skills, trunk groups, vectors, or VDNs.

Navigator 
A window that is displayed after you select it from the Tools menu or toolbar in 
the CentreVu Framework window. It consists of two panes: a hierarchical “tree” 
view of your Call Center World on the left and a list of objects or entities on the 
right.

Nonprimary split/skill
When a call is queued to multiple splits or skills, the second and third splits or 
skills to which the call queues in a VDN are called nonprimary splits or skills. 
They are also referred to as secondary and tertiary splits or skills, respectively.
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Object 
Any item which may appear in your Call Center World through the Navigator 
tool. Objects can be containers of other objects or entities, for example, a VDNs 
folder, or an object may be an administrable entity itself, for example, a VDN.

Primary skill
Skills that are assigned to an agent. Primary skills are the areas in which the agent 
has the most expertise.

See also Agent Skill.

Pseudo-ACD 
An area that you create on your CMS to place previously backed-up ACD  data. 
A pseudo-ACD is not a live or real ACD and does not communicate  with any 
switch.

Queue
A holding area for calls that are waiting to be answered in the order in which they 
were received. Calls in a queue may have different priority levels, in which case, 
calls with a higher priority are answered first.

Queued
A trunk state in which an ACD call has seized the trunk and is queued to a split/
skill waiting for an agent to answer.

Read permission
The CMS user can access and view data, for example, run reports or view the 
Dictionary subsystem. Read permission is granted from the User Permissions 
subsystem.

Real-time database
Consists of the current and previous intrahour data on each CMS-measured agent, 
split, trunk, trunk group, vector, and VDN.

ScratchPad
The Default ScratchPad name is a container area on your PC that is designed to 
save vectors offline when a switch or ECS link or CMS connection is not 
available. You can create a hierarchy of sub-folders nder the default folder by 
selecting New ScratchPad from Navigator’s File menu.
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Secondary skill 
Skills that are assigned to an agent. Secondary skills are the areas in which the  
agent does not have extensive expertise or are not the agent’s preference.  
Secondary skills a used in G3V2 through G3V4 with EAS.

See also Agent skill, Skill level.

Seized
A trunk state in which a call is using the trunk either incoming or outgoing.

Service observing-VDNs
A feature available with G3V4 or later switches that gives a telephone user the 
ability to monitor the treatment a call receives as it is processed by a VDN.

Shortcut key
A keyboard keys or key combinations such as CTRL+N or CTRL+S that provides 
a shortcut to an action that is available from a menu.

Shortcut menu 
A menu that appears when you right-click a selection, a toolbar, or a taskbar 
button, for example. It lists commands pertaining only to that screen region or 
selection.

Single-user mode
A mode in which only one person can log in to CMS. Data continues to be 
collected if data collection is “on.” This mode is required to change some CMS 
administration.

Skill
An attribute that is assigned to an ACD Agent. Agent Skills can be thought of as 
the ability for an Agent with a particular set of skills to handle a call that requires 
one of those skills. Also, a skill can be defined as a specific customer need or 
requirement, or perhaps a business need of a call center.

Skill hunt group 
When EAS is enabled, calls are routed to specific skill hunt groups. These skill  
hunt groups are usually based on the needs of the customers. Agents are not 
assigned to a skill group, but they are assigned specific skills that become active 
when they log in to their telephones.

Skill level 
A priority level from 1 (highest) to 16 (lowest) that indicates an agent's level of  
expertise or ability to handle calls to the given skill. Skill levels are used with ECS 
Version 5 and later.



  
Glossary CentreVu Visual Vectors User Guide

GL-10

Split
A group of extensions that receives special-purpose calls in an efficient, cost-
effective manner. Normally, calls to a split arrive primarily over one or a few 
trunk groups.

Staffed agent
An agent who is currently logged in to the switch.

Station
An unmeasured extension. An extension that is not currently staffed by an agent 
or that is a member of an unmeasured split/skill or hunt group.

Status bar 
A status bar is across the bottom of some windows. The status bar shows 
information about the current action in that window.

Switch
A private switching system that provides voice-only or voice and data 
communications services including access to public and private networks for a 
group of terminals within a customer’s premises.

Time format
The standard format for entering times on CMS reports.

Acceptable formats are:

• AM/PM format (for example, 7:30AM-5:00PM).

• Military time format (for example, 7:30-17:00).

Title bar 
A title bar is across the top of most windows. The title bar shows the name of that 
particular window, for example, Navigator. Titles of open tool windows are listed 
on the Window menu of CentreVu Framework.

Toolbar 
A toolbar is under the menu bar of most windows. Toolbar icons represent actions 
you can perform.

Tooltips 
Brief descriptions that display when the mouse pointer is over a toolbar button or 
icon. 

Trunk
A telephone circuit that carries calls between two switches, between a Central 
Office (CO) and a switch, or between a CO and a telephone.
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Trunk group
A group of trunks that are assigned the same dialing digits. These digits are either 
a telephone number or a Direct Inward Dialed (DID) prefix.

Universal Call Identifier (UCID)
A number that uniquely identifies a call in a network of nodes that support UCID. 
This number is a part of the records in the Call History feature of CMS.

User ID
The login ID for a CMS user.

User permissions
An area of the CMS server that allows the CMS administrator to define what each 
user has access to.

VDN
See Vector Directory Number.

VDN Assignment 
The VDN Assignment Wizard, accessed from CentreVu Framework, guides you 
through the process of assigning a vector and skill preference to a VDN. The 
windows that are displayed after you select Vector Id or Skill Pref from the 
context menu of a VDN object are part of this tool.

VDN calls-counted
Also known as counted-calls to VDN and active VDN calls. A Call Vectoring 
capability available with G3V4 or later switches. Counted-calls to VDN is a 
parameter of the “go to step” and “go to vector” commands that provides 
conditional branching (to a different step in the same vector or to a different 
vector) based on the number of incoming trunk calls a VDN is currently 
processing.

VDN of Origin  Announcement (VOA)  
A short announcement that is assigned to a VDN through switch  administration. 
The VOA identifies the origin or purpose of a call for the  call center agent who 
answers the call.
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VDN skill preference
A prioritized list of agent skills administered for a VDN that are required or 
preferred for the answering agent. VDN Skill Preferences represent the 
requirement that a call be routed to an ACD agent with a particular ability or set 
of abilities.

For EAS only, up to three skills can be assigned to a VDN. Calls use VDN skills 
for routing based on the preference that you administer in the vector. VDN skill 
preferences are referred to in the vector as “1st,” “2nd,” or “3rd.”

Vector
A list of steps that process calls in a user-defined manner. The steps in a vector 
can send calls to splits, play announcements and music, disconnect calls, give 
calls a busy signal, or route calls to other destinations. Calls enter vector 
processing via VDNs, which can receive calls from assigned trunk groups, from 
other vectors, or from extensions connected to the switch.

Vector command  
A vector step that describes the action to be executed for a call, for  example, 
Queue, Check, Disconnect.

Vector Directory Number (VDN)
An extension number that enables calls to connect to a vector for processing. A 
VDN is not assigned to an equipment location. It is assigned to a vector. A VDN 
can connect calls to a vector when the calls arrive over an assigned automatic-in 
trunk group or when calls arrive over a dial-repeating (DID) trunk group and the 
final digits match the VDN. The VDN by itself may be dialed to access the vector 
from any extension that is connected to the switch.

Vector Editor 
This software tool, accessed from CentreVu Framework, allows you to create and 
edit vectors visually, by using the drag-and-drop method to move icons that 
represent commands from a palette and arrange them into vector steps in a work 
area. You can attach comments, change layout, and save and print the vectors.

Vector file
The Windows accessible file that is created by the Export operation. An exported 
vector file can contain one or more vector objects.

Vector object
A term that defines a vector that is accessible to the Visual Vectors application. 
Vector objects include vectors in a DEFINITY switch, vectors stored in the Visual 
Vectors ScratchPad folder, and vectors within a vector file.
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Vector step
One processing step in a vector. A vector step consists of a command and one or 
more conditions or parameters. These conditions or parameters are found on a 
step’s Properties window in Visual Vectors client software.

Vector step condition
A condition that accompanies a vector command that defines the circumstances 
in which the command will be applied to a call. These conditions are found on a 
step’s properties window in Visual Vectors client software.

VOA  
See VDN of Origin Announcement.

Visual Vectors Client 
Client software that provides a graphical user interface for creating or modifying 
configured elements of ACDs that are connected to a CMS.

Visual Vectors Server 
Server software that enables administration, for example, changing or modifying 
configured elements, for ACDs that are connected to a CMS.

Write permission
A CMS user with write permission can add, modify, or delete data and execute 
processes. Write permission is granted from the User Permissions subsystem.
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Edit, Vector Editor, 5-10

File, 3-10, 4-10

File, Vector Editor, 5-9

Help, 3-12, 4-13, 5-13

Insert, Vector Editor, 5-12

Tools, 3-11
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Window, 3-12

messages

status, 4-10

Messaging Skill step, 5-37
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